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/\ SAFETY INSTRUCTIONS

"DANGER", "WARNING" and "CAUTION" notices appear throughout this manual. it is the
responsibility of the operator and installer of the equipment to read, understand and follow
these notices. If you have any questions regarding these safety instructions, please con-
tact a FURUNO agent or dealer.

This notice indicates a potentiaily

hazardous situation which, if not
avoided, will result in death or

serious injury.

This notice indicates a potentially

hazardous situation which, if not
WAR N I N G avoided, could result in death or

serious injury.

This notice indicates a potentially

T hazardous situation which, if not
CA U I O N avoided, could result in minor or

moderate injury, or property damage.




SAFETY INFORMATION
FOR THE OPERATOR

AWARNING

Do not open the cover of
the equipment.

This equipment uses high
voltage electricity which can
shock, burn, or cause death.
Only qualified personnel
should work inside the
equipment.

/A CAUTION

Do not place liquid-filled containers on
the top of the equipment.

Fire or electrical shock can result if a liquid
spills into the equipment.

Do not dissasemble or modify the
equipment.

Fire, electrical shock or serious injury can
result.

Do not place heater near the equipment.

Heat can melt the power cord, which can
result in fire or electrical shock.

Do not operate the unit with wet hands.

Electrical shock can result.

Immediately turn off the power at the
ship's mains switchboard if water or
foreign object falls into the equipment
or the equipment is emitting smoke or
fire.

Continued use of the equipment can cause
fire, electrical shock or serious injury.

Use the correct fuse.

Use of the wrong fuse can cause fire or
equipment damage.

WARNING Label attached

(/A WARNING A\

To avoid electrical shock, do not
remove cover. No user-serviceable
parts inside.

A == A

Name : Warning Label (1)
Type : 86-003-1011-0
Code No. : 100-236-230




SAFETY INFORMATION
FOR THE INSTALLER

AWARNING

Only qualified personnel
should work inside the
equipment.

This equipment uses high
voltage electricity which can
shock, burn, or cause death.

/A CAUTION

Ground the equipment.

Ungrounded equipment can
give off or receive electro-
magnetic interference or
cause electrical shock.

Turn off the power at the ship's mains
switchboard before beginning the
installation. Post a warning sign near
the switchboard to ensure that the
power will not be applied while the
equipment is being installed.

Serious injury or death can result if the
power is not turned off, or is apptied while
the equipment is being installed.

Confirm that the power supply voltage
is compatible with the voltage rating
of the equipment.

Connection to the wrong power supply can

cause fire or equipment damage. The
voltage rating appears on the label at the
rear of the equipment.
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Foreword

Furuno Electric Company thanks you for selecting and purchasing the Furuno DP-5 NBDP
(Narrow Band Direct Printing) Terminal. We are confident you will discover why the Furuno
name has become synonymous with quality and reliability. To get maximum performance
from your unit, please carefully read and follow the recommended procedures for installa-
tion, operation and maintenance.

The DP-5 is an advanced, microprocessor controlled NBDP Terminal designed to protect
teleprinting communications from radio signal mutilation due to interference in the radio
signal path. It provides dependable, fully automatic error-free telex communication with
other ships, as well as with any telex subscriber, in full compliance with all GMDSS
requirements for automatic radiotelex operation.

The microprocessor used in the DP-5 enables fully automatic operation of your radio station,
including automatic frequency scanning, unattended reception and transmission of mes-
sages, automatic adjustment of transmitter frequency, and more. Operation is simplified by
the use of menus: Simply move the cursor to items on the screen that you want to select.

The DP-5 provides a complete line of word processing facilities in its Text Editor, where you
may create, edit and store multiple messages for later transmission.

FEATURES

Simple operation by use of pop-up menus

CRT displays information in easy-on-your-eyes white on black (color scheme is revers-
ible)

3.5" floppy disk drive for storage of text, payroll lists, etc. on floppy disks
Automatic frequency control and message handling permit unattended operation
Real time printing of incoming messages

Storage capacity for 100 user channels

Remote control of a transceiver by commands entered via the keyboard

Inputs for CIF or NMEA data —to display ship’s L/L position, water temperature, and
more on the CRT

Built-in crypto device (scramble) for protected transmission and reception of confidential
messages

B Fully automatic radiotelex by use of macro operation
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1. Communications

Communication Mode
Communication Protocol

[D Code

Line Code
Modulation

Tone Frequency
(mark/space)

Tone Frequency
Tracking Range

Line Input/Output

2. Communication
Features

3. Display

Specifications

ARQ, FEC, DIRC (FSK)
CCIR Rec. 625, 476-3, 490, 491, 492

4 unit, 5 unit and 9 unit

4B/3Y fixed mark (International)
AFSK

1615/1785 Hz, 1415/1585 Hz,
1815/1985 Hz (=0.5 Hz)

80 Hz

30dBmto + 10 dBm, 600 chms bal-
anced

. Timer transmission and receiving (maxi-
mum 10 stations)

« Scramble operation (maximum 5 differ-
ent code sets)

« Frequency scanning (maximum 10
groups, 20 channels/group)

« Morse code conversion (transmit only)
. Storage for up to 100 user channels

. 12" CRT display (white on black)

. 80 characters/line, 25 lines/screen

« Character construction 7 x 9 dots

. Selection shown in black on white

Xi



Specifications

4. Ambient Temperatue -15to 55°C
Range
5. Power Supply Main Unit: 10-40 VDC (100/120/220/240
VAC operation by optional Rectifier
PR-62), 40W

Printer: 100/120/220/240 VAC (24 VDC
operation by Inverter TR-2407), 33VA

6. Weight Main Unit: 16 kg approx.
Keyboard: 2 kg approx.
Printer PP-500 (option): 5 kg approx.
Rectifier PR-62 (option): 3 kg
Inverter TR-2407 (option): 8.5 kg

7. Other Features . Text editing screen
« Floppy disk management
- NMEA/CIF data input and display

« Remote control of transceiver

« Printing
. Self-test
8. Equipment Connectable
Transceiver FS-8000, FS-5000,
FS-1500/1550
Receiver RV-118, RV-128, RV-1(7, RV-117
CIF/NMEA Data LC-90, GP-500, FSN-70, etc.

Input Terminal

9. Color Cover: 25GYS/1.5
Panel: N-3

Xii



RADIOTELEX
COMMUNICATION

General

Telex subscribers can attest to radiotelex as a reliable and efficient method for sending and
receiving teleprinter connections. Telex subscribers, especially those who often use HF-
band radio circuits, will also attest that the telex connection is subject to interference from a
variety of sources, including atmospherics, fading and noise disturbance. This interference
plays havoc with radio signals, resulting in the receiving of information different from the
intended information. Thus a means must be provided to prevent mutilation of radio signals
by interference on HF-band radio.

Radiotelex communication today owes its reliability and efficiency to error detection and
correction. The CCIR (The International Radio Consultative Committee) defined both a
constant-ratio code for automatic error detection and requirements for the error correction
in Recommendation 476-3.

Code Description

The DP-S employs a 7-element synchronous code providing 2” = 128 combinations. Among
these 128 combinations, there are 35 constant-ratio combinations having a ratio of 3 ()
mark bits to 4 (B) space bits. This ratio is used to test the validity of each received character.

Of the 35 combinations, 32 are used for the required alphanumeric teleprinter signals. The
remaining three 7-element codes are used exclusively for operational purposes. These are:

Idle Signal @ (ARQ Mode), Phasing Signal 1 (FEC Mode)
Idle Signal 8
RQ Signal (ARQ mode), Phasing Signal 2 (FEC Mode)

Transmission rate is 100 bauds. If the 4B/3Y ratio is disturbed due to interference, the output
of the receiver is blocked to restrict the mutilated character from passing on to the
teleprinter.

Frequency Shift

The frequency shift is 85 Hz with a center frequency of 1700 Hz, as specified in CCIR
Recommendation 476-3.

Space Frequency........ 1700+85 = 1785 Hz
Mark Frequency......... 1700-85 = 1615 Hz

1-1



RADIOTELEX COMMUNICATION ARQ Mode (A-Mode)

ARQ Mode (A-Mode)

Description

The ARQ (Automatic Re-transmission request, or Automatic Request for repetition) Mode
allows private communications between any two stations using semi-duplex communication.
Reception confirmation is done to assure that each character is received correctly. Since the
two stations (automatically) exchange identities, this affords some degree of protection for
confidential messages.

Traffic Exchange Sequence

In the ARQ mode two stations communicate directly with one another. One station sends
information and receives controls signals, while the other station receives information and
sends confirming controls signals. The first station is the ISS (Information Sending Station),
and the second is the IRS (Information Receiving Station). These functions are interchan-
geable by a special control signal.

The station which initiates the call is the Master Station (MS). The MS initiates the call by
sending the selective identity code of the called station, consisting of an RQ signal and two
traffic information signals, listening between blocks.

Example: Identity Code XQKM

T ]
I

X | RQI Q KEM RQ .

i

Calling Block 1 Calling Block 2

Example: Identity Code PEARDBY

P | Ra| E EROAR ‘D B:‘r’}
L | | S S B

Calling Block 1 Caliing Block 2 Calling Block 3

Fig. 1-1 Transmission of Identity Code

The Slave Station (SS) recognizes own identity code received and answers it is ready by
sending a control signal. The calling station then initiates normal traffic.

The ISS sends information in blocks of three characters. Each character is sent at the rate of
100 bauds, amounting to 70 ms for one character or 210 ms for one character block. The
block repetition cycle is 450 ms, so there is 240 ms during each cycle that the ISS is not
sending. This time is taken up by propagation time from the ISS to the IRS, 70 ms for the
IRS to send its service information signal, and the return trip back to the ISS.




ARQ Mode (A-Mode) RADIOTELEX COMMUNICATION

The IRS listens between blocks and sends a control signal (CS1 or CS2) to request either the
next block, or retransmission of the last block in the case of error. Request for retransmission
may be repeated up to 32 times, until the completed block have been received error-free.
After 32 times, the ISS automatically initiates a new call.

INFORMATION CONTROL SIGNAL
S5 characters 1 character
¢>f 70 ms P 70 ms

210 ms —P
450 ms P

Fig. 1-2 ARQ Mode Traffic Exchange Timing

Once an entire message is received (error-free), a station may switch its function from the
IRS to the ISS by means of a control signal (CS3). This change is done by either the ISS by
the sequence of " Figure shift + ?", or by the IRS operator by activating the "OVER" control.
Uponreceipt of CS3, ISS answers with a Saf block. This switches the ISS into IRS. However,
the original Master and Slave stations’ status remains unchanged, since the Master Station
always controls the radio circuit.

Termination of Communication
Only the ISS may terminate the established circuit. It does this by sending three "idle signals

a." The IRS and ISS exchange control signals, each reverting to standby after acknowledging
each other’s control signals. Then, the connection is cleared.




RADIOTELEX COMMUNICATION FEC Mode (B-Mode)

FEC Mode (B-Mode)

Description

The FEC mode is for one-way, uninterrupted transmission of messages, for example,
weather forecasts and emergency bulletins, to no one particular station or stations. The
sending station is known as the BSS (B-Mode Sending Station), the receiving station the BRS
(B-Mode Receiving Station).

This mode uses a simple forward-error correcting (FEC) technique of sending each charac-
ter twice at a 280 ms interval. The first transmission is termed DX (direct transmission), the
second RX (repeated transmission).

Message: "a b ¢ d e f g h i j"

first transmission: a b c d e f g h i J

second transmission: a b ¢ d e f g h i J
280 ms

output code example: a b cladbecfdgehfigijh i J

Fig. 1-5 FEC Mode Transmission Technique

The receiving station tests the DX and RX characters for adherence to the 4-mark/3-space
constant ratio, and prints only unmutilated DX or RX characters, or prints a space if both
are mutilated.

Another version of the FEC mode is the FEC-selective mode. This mode uses a call code for
selective calling to one or more stations. Only those stations with the correct code will
receive the data correctly.

Initiating a Call

When a BSS initiates a broadcast call it transmits synchronizing signals to align phasing of
the BRS. Upon detection of this signal the BRS’s are switched to the receiving condition and
will remain in this condition until the completion of the message. If the mutilated character
error rate exceeds a certain percentage, the BRS reverts to standby condition.

Termination of Communication

The sending station sends three consecutive idle signals @ immediately after the last trans-
mitted information signal in the DX position.

1-4



SYSTEM INTRODUCTION

General

The Furuno DP-5 Narrow Band Direct Printing (NBDP) Terminal consists mainly of a
display unit and a keyboard. A printer is available optionally.

TRANSCEIVER

DISPLAY UNIT

DP — 500 PP - 500
CRT (OPTION)
_____@): 100,7220VAC
POWER SWITCH g
CIF (NMEA)
POWER LAMP \ [
— N :NAVIGATORl
= 3
10~40VDC ="
1L T o FLOPPY DISK DRIVE

EJECT BUTTON
w0 ) )Y

Fig. 2-1 System Configuration

Connected to a transceiver, the DP-5 functions as a narrow band printing terminal, transmit-
ting and receiving radiotelex messages.

Display of ship’s L/L position, speed, course, water temperature and depth on the CRT is
possible when connected to a device or interface which outputs these data in CIF or NMEA
data format.

Display Unit

The display unit contains a CRT and a floppy disk drive. Controls for power and CRT
illumination are on the left-hand side of the unit. When you turn the power switch on, the
(green) power lamp below the switch lights.

Screen color is available in two choices: normal, white on black, or reverse, black on white.
For further details, see TEXT EDITOR PARAMETERS on page 3-12.




SYSTEM INTRODUCTION

Display Unit

Floppy Disk Drive

The DP-5 provides a floppy disk drive for saving files to floppy disks. (Files can also be saved
to an internal memory.) The type of floppy disk used is a (commonly available) 2DD type

(double sided double density) 3.5" floppy disk.

Inserting and Removing a Floppy Disk

To set a floppy disk into the floppy disk drive, insert
it such that the arrow on the disk is pointing forward
and is on the left. Release hold when the eject button
pops out, indicating the disk is properly inserted.

To remove a floppy disk, first confirm that the
(orange) access lamp is off, then press the eject but-
ton. Never remove a floppy disk while the access
lamp is lit, or after turning the power off, since this
may erase information stored on the disk.

ACCESS LAMP

Care and Handling

Floppy disks must be handled with the utmost of
care. Keep them away from direct sunlight, heat
sources, and active gases. Do not place a disk near
any magnetic field, since this erases all information
stored on the disk. Television sets, telephones and
large appliances are common objects which emit
magnetic fields. Keep your disks at least a foot—
preferably more —away from such devices. After
use, replace the disk in its protective case and store
it in a cool, clean place. You should always label
your disks so you can know what you have stored on
them and to help find the disk you need quickly.

Each floppy disk has a write protect tab which
prevents accidental erasure of information stored
on the disk. To disable writing to the disk, move the
tab downward.

EJECT BUTTON

Fig. 2-2 Inserting a Floppy Disk

<lo

HOLE

TAB

Fig. 2-3 Disk Write Protection Tab




Fite Edit Operate Window

Keyboard SYSTEM INTRODUCTION

Keyboard

The DP-5 provides a "IBM type" alphabet keyboard with cursor controls for operating the
system. The keyboard is powered from the display unit through the supplied connection
cable.

The DP-5 is operated from the keyboard, and is almost 1009 keyboard controlled. Opera-
tion is simplified by the use of menus which you access by pressing a function key, numbered
F1-F8 at the top of the keyboard. The figure below shows the function menu and its
corresponding function keys.

NOTE: The function menus FILE, OPERATE, WINDOW, STATION, TERMINAL, EDITOR
and SYSTEM appear in the highest level of illumination when the DUAL FONT
feature is turned on in the TERMINAL menu. For further details see TERMINAL
SETTINGS on page 3-12.

| Editor System

Station Termina
—f =10 -0 - 142

LR HR Ower Ereak

A

B 000

numeral input only
(all other keys and
functions inoperative)

7 : inoperative

Fig. 2-5 Keyboard

2-3



SYSTEM INTRODUCTION Function Menus

Function Menus

The function menus, which you access by pressing the function keys at the top of the
keyboard, control most operations of this unit. To familiarize yourself with each menu, turn
the unit on and try operating the keys as you review this section, provided the unit has been
installed.

Menu Conventions
Inverse Video

As you move the cursor down through a menu, each menu option, initially shown as white
on black, inverses to black on white. This highlighting indicates that the item is available for
selection.

Underline

The underline shows current selection on the menu screens. In the figure below, for example,
the underline is beneath both MAIN (main memory) and RECEIVE, meaning that main
memory is selected rather than disk memory and "receive” is selected rather than "send".

Rute Operation Set Up
Operation : OP1
Station ¢ CHOUSHI EE—
Start Time - i B:35: 0 Main
Stop Time :3:10: 0 -
ReceiveSend : Recesive Send Disgk
File to s2nd : ——————J

Fig. 2-6 The Underline

Keys You Will Commonly Use

FUNCTION: Controls menu selection.

ENTER: Terminates keyboard operation, or inserts a carriage return.
ESC: Returns control to previous screen.

PAGE UP: Goes to the previous page at edit screen.

PAGE DOWN: Goes to the next page at edit screen. The above two keys are also

used to view the contents of the communication buffer, which stores
currently transmitted/received message.

CURSOR: ([<1, 111, [»), [{]) Controls the cursor.

BACKSPACE: Deletes the character to the left of the cursor.

CAPS LOCK: Locks the keyboard for capital letters.

SHIFT: Alternates between capital letters and small letters.

Ctrl + G: Sounds on audible alarm to other party. (Press the keys simulta-
neously.)

PRINT SCREEN: Prints contents of the current screen.

24



Function Menus

SYSTEM INTRODUCTION

HOME: Moves the cursor to the top in an editing message.

END: Moves the cursor to the bottom in an editing message.
ALT: Does the short-cut operation, combined with alphabet key.
INSERT: Works same as PASTE function.

Basic Operation

When a function key is pressed, the individual menu screen appears. The below shows the
FILE menu and the EDITOR menu.

File

1: New
: Open
: Close

L M

7: Real Time Printing
8: File to Print
9: Cancel Printing

0: Clear Buffer

(a)

(b)
Fig. 2-7

Editor

Alt-N 240

A1t-0 Scroll Page Full Half

Alt-Q Screen Color Normal Inverse
------- Line No. OFF ON

Alt-D Cursor Square Underline
------- Blinking Cursor OFF ON

Alt-S | | e T .
------- No. Of Characters 69

No. Of Lines 60
Alt-pP

Numeric number is attached to each item of the menu for the menu screens used frequently
as shown in the above figure (a). At this case, press numeric key you want to do then the item
with numeric number will be executed. Instead of this method, the arrow keys and ENTER
key can be used. Press the [} ] or [ 1] key to select an item you want followed by the ENTER

key.

For the menu without numeric number as shown in above figure (b), press the [{ ] or [1] key
to select a desired item and then press the ENTER key to execute it.
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SYSTEM INTRODUCTION

Function Menus

Short Cut Key Operation

Short cut key operation is operative for some items of menus. Press an alphabetic key,
holding down the [ALT] key. This is operative without pressing a function key. The short cut

key operation is listed below.

Short Cut Key

ALT + N Same as New in File menu

ALT + O Same as OPEN in File menu

ALT + Q Same as CLOSE in File menu

ALT + D Same as Delete in File menu

ALT + S Same as SAVE in File menu

ALT + P Same as REAL TIME PRINTING in File menu
ALT + X Same as UNDOQ in Edit menu

DELETE Same as in CUT in Edit menu

ALT + C Same as in COPY in Edit menu

INSERT Same as PASTE in Edit menu

ALT + A Same as in SELECT ALL in Edit menu

ALT + F Same as in SEARCH in Edit menu

ALT + R Same as in REPLACE in Edit menu

HOME Same as GOTQ TOP in Edit menu

END Same as in GOTO BOTTOM in Edit menu
ALT + L Same as in GOTO LINE in Edit menu

ALT + V Changes currently opened file on the CRT alternately.
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Menu Description

FILE (function key F1)

The file menu controls the flow of information into and out of the DP-5. The figure below
shows the file menu.

File
1: New Alt-N
2: Open Alt-0
3: Close Alt-Q
4: Delete Alt-D
5: Save Alt-S

7: Real Time Printing Alt-P
8: File to Print
9: Cancel Printing

0: Clear Buffer

Fig. 2-8 File Menu

: New

: Open

: Close

: Delete
: Save

: Format

: Real Time
Printing

: File to Print
: Cancel Printing

: Clear Buffer

Opens a new file to create a message.

Retrieves a previously stored file from the main memory
or a floppy disk.

Removes a file from a working area.
Deletes a file from the memory.
Saves a file to the memory.

Formats a floppy disk.

Turns real time printing (printing an incoming/outgoing
message while it is being received/transmitted) on and off.

Prints a file or the contents of the memory.
Stops the printer.

Clears both the screen and communication buffer mem-
ory.
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Function Menus

EDIT (function key F2)

The edit menu allows you to cut, copy and paste text, search for words, position the cursor,
etc. This function is operative at the message editing screen only.

1: Undo

2: Cut

3: Copy

4: Paste

5: Select All

6: Search

7: Replace

8: Goto Top

9: Goto Bottom

0: Goto Line

Edit
1: Undo Alt-X
2: Cut Delete
3: Copy Alt-C
4: Paste Insert
5: Select All Alt-A
6: Search Alt-F
7: Replace Alt-R
8: Goto Top Home
9: Goto Bottom End
0: Goto Line Alt-L

Fig. 2-9 Edit Menu

Cancels the last change (cut, copy or paste).

Removes the selected text and stores it in the paste buffer.
(Previous text in the buffer is cleared.)

Copies the selected text and stores in the paste buffer.
(Previous text in the buffer is cleared.)

Inserts the text stored in the paste buffer at the current
location of the cursor.

Selects the entire current file for cut and copy.

Searches a file for a character string,

Replaces a word with a different word or character string.
Brings the cursor to the top line of the current file.
Brings the cursor to last line of the current file.

Moves the cursor to the desired line in the current file.
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OPERATE (function key F3)

The OPERATE menu controls transmitting and receiving.

Operate

l: Call Station

2: Macro Operation

3: File to Send
4: Cancel Sending

0: Manual Calling
A: Set Frequency

Fig. 2-10 Operate Menu

: Call Station

: Macro Operation
: File to Send

: Cancel Sending

: Scan Start/
Stop

: Manual Reception

: Timer Operation
: Scramble ON/OFF

: High Tension
ON/OFF

: Manual Calling

: Set Frequency

Selects a station in the station list registered.
Enables fully automatic operation.

Selects a file for transmitting.

Stops sending a file during transmission.

Starts and stops frequency scanning.

Selects communication mode for reception;
AUTO/ARQ/FEC/DIRC.

Enables timer operation.
Turns scramble (crypto) operation on and off.

Turns on/off transmitter high voltage of Furuno make
radio.

Selects a mode for transmitting and sets ID number of
other party for manual calling.

Sets a transmission and reception frequencies for manual
calling.
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Function Menus

WINDOW (function key F4)

The window menu lets you display various data.

FILE 1
FILE 2

View Paste Buffer

Display CIF (or NMEA)
Data

Calendar

Remote A/B

Distress Frequency
Table

Window

< FILE 1

2: < FILE 2

6: Remote A
7: Remote B

8: Distress Frequency Table

Fig. 2-11 Window Menu

Displays name of currently opened file(s).

Displays the contents of the paste buffer memory. The
paste buffer memory stores cut or copied text.

Displays ships L/L position, speed, course, water tempera-
ture and depth when the DP-5 is connected to a device
which can output this data in CIF or NMEA format.

Displays desired calendar month and year.

Entering commands to this screen enables remote control
of a Furuno make radio transceiver connected to Remote
A and Remote B terminal.

Displays all distress frequencies.
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SYSTEM INTRODUCTION

STATION (function key F5)

Selects communication conditions.

Station

1: Station Entry

¢ Group ID Entry (4/5 digit)
¢ Group ID Entry (9 digit)

7
8
9: Select ID Entry (4/5 digit)
0

: Select ID Entry (9 digit)

1: Station Entry

2: Timer Operation
Entry

3: Scan Entry

4: Scramble Code
Entry

5: User Channel
Entry

6: Answerback Code
Entry

7: Group ID Entry (4/5 digit)

8: Group ID Entry (9 digit

9: Select ID Entry (4/5 digit)

0: Select ID Entry (9 digit

Fig. 2-12 Station Menu

Stores station list.

Sets parameters for timer operation.

Creates scan groups for frequency scanning.

Creates scramble code groups for scramble (crypto)

operation.

Registers user channels.

Registers own vessel’s answerback code

)

)

Registers own vessel’s group ID code.

Registers own vessel’s selective ID code.
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Function Menus

TERMINAL (function key F6) ..... Refer to page 10-5.

The TERMINAL menu sets communication conditions.

Rx MSG Save

Active File Auto Send
Signal Tracking

Edit before Sending

ARQ Error Count
Communication Time

Dual Font (Bold: Sending)
Echo

Sending Volume display
Comm. Status display

ARQ/FEC Center Freg
Shift Freq
DIRC Center Freq
Shift Freq
Rate (wpm)
CW Mod Freq
Rate (wpm)
Line Out Level (dBm)

Remote A Mode
Rate (baud)
Start Bit
Data Bit
Stop Bit
Parity Bit
Delimiter

MIF Tune

Freeze
AGC

Remote B Mode
Rate (baud)
Start Bit
Data Bit
Stop Bit
Parity Bit
Delimiter

MIF Tune

Freeze

CIF/NMEA Mode
CIF Rate

Terminal

Change Default

OFF Main Disk
OFF ON
OFF ON
NO YES
OFF ON
OFF ON
OFF ON

0 (Hz)
60 66 75 100 132

1615 1785 (Hz)

10 12 14 16 18 20 22 24 26 28

OFF RCVR XMT RT DSC

300 600 1200 2400 4800 9600
1 Bit

7 Bit 8 Bit

1 Bit 2 Bit

Even 0Odd None

CR CR + LF LF

OFF ON

OFF RCVR XMT RT DSC

300 600 1200 2400 4800 9600
1 Bit

7 Bit 8 Bit

1 Bit 2 Bit

Even 0dd None

CR CR + LF LF

OFF ON

OFF ON

OFF ON

CIF NMEA
600 1200 2400 4800

Fig. 2-13 Terminal Menu
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EDITOR (function key F7)

The EDITOR menu formats the text editor screen.

SYSTEM (function key F8)

Editor
Tab Width 240
Scroll
Screen Color
Line No. OFF ON
Cursor
Blinking Cursor OFF ON
No. Of Characters 69
No. Of Lines 60

Page Full Half
Normal Inverse

Square Underline

Fig. 2-14 Editor Menu

Refer to page 10-9.

The SYSTEM menu selects system settings.

* K K X ¥

Monitor OFF
Line In Level 0 1 2
Line Out Level 0 1 2
Beep Level 0 1 2

CRT Economy Mode OFF ON

File Partial View OFF ON

Slave Delay 5 msec

BK Timing PreTone 10 msec

PostTone 0 msec

Mute Timing PreBK 0 msec

PostBK 0 msec
Reception Alarm OFF ON
Time System OFF UTC

Time & Date

Printer PP-500 OTHER
Header File Name OFF ON

Time OFF ON
Footer QFF ON
Language
Self Test
Version No. Ver. 2.xx
Modem Version No. Ver. 1.10

3 4
3

4
301

5
5
5

System
ﬁﬂ Change Default

Line In Line Out

6
6
6

(0-50 msec)

(0-100 msec)

(0-20 msec)
(0-20 msec)
(0-20 msec)

SMT JST

1990/ 1/ 1/ 20:

0

7
7
7

Normal Norway Sweden UK (]\[)

Fig. 2-15 System Menu
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F9 (WRU: Who Are You?)

This key, when pressed in the ARQ mode, requests other station’s answerback code.

F10 (HR: Here Is)

This key, when pressed in the ARQ mode, sends your vessel’s answerback code.

F11 (OVER)

This key, when pressed in the ARQ mode, changes the direction of traffic; the information
receiving station becomes the information sending station, the information sending station
becomes the information receiving station.

F12 (BREAK)

This key disconnects the communication line.
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PREPARATIONS

General

This section provides the procedures for preparing the DP-5 for transmitting and receiving.
You will need to;

1) Register your vessel’s ID code and answerback code
2) Create a list of stations

3) Provide parameters for timer operation

4) Enter frequency scanning groups

5) Prepare a scramble table (if required)

6) Register user channels

7) Format the text editor screen

8) Enter terminal settings

9) Enter system settings

Most of the system and terminal setting should be done by a installation engineer.

All other items are found in the STATION menu. Press function key F5 to display the
STATION menu.

Station

l: Station Entry

7: Group ID Entry (4/5 digit)
8: Group ID Entry (9 digit)
9: Select ID Entry (4/5 digit)
0: Select ID Entry (9 digit)

Fig. 3-1 Station Menu




PREPARATIONS Answerback Code & ID Code

Answerback Code & ID Code

Enter your vessel’s answerback code and ID code as follows.

CAUTION

The answerback and ID code numbers can be written only once;
be sure to enter the codes correctly.

Answerback Code
Procedure

1. Press function key F5 and then the [6] key. The display something like Fig. 3-2 appears. (To
select a menu you want, the [{] or [1] keys followed by the ENTER key can be used
instead of a numeric key.)

Answerback Code Entry
Answertack Code

Fig. 3-2 Answerback Code Entry Screen

2. Enter your vessel’s answerback code (max. 20 characters, including spaces). Press the
ENTER key. The prompt OK/CANCEL asks for verification of data. If correct, press the
ENTER key again.

Example
Answerback Code Entry
Answerback Code
12345 FURU
Cancel
Confirm the 'CCDE® befors pressing ENTER key.
You cannot change the CODE once it has been entered.

Fig. 3-3 Confirmation message

3. For final verification of the data, the above CAUTION appears. If correct, press the ENTER
key again, then the registration of the answerback code is completed.

NQTE: Form of answerback depends on coast station. Some request ship name and/or
callsign.
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ID Code

Procedure

1. Press function key F5 and then the [7], [8], [9] or [0] key to enter the Group ID Code (4 or
S digits), Group ID Code (9 digits), Select ID Code (4/5 digits) or Select ID Code (9 digits)
respectively.

GBroup 1D Entry
Group ID Code (4 or &)

Fig. 3-4 ID Code Screen

2. Enter group ID or select ID. Then, press the ENTER key. A prompt asks for verification of
data. If correct, press the ENTER key.

Example

Group 1D Entry
Group D Code (4 or

Cance!

123245

Confirm the ’'CODE’ before pressing ENTER kev.
You cannot change the CODE once it has been entered.

Fig. 3-5 Confirmation Message

3. For final verification of the data, the above CAUTION appears. If correct, press the ENTER
key again, then the registration of the ID code is completed.

3-3
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Station List

The station list provides abbreviated dialing with storage for up to S0 stations, one frequency
pair (RX and TX) per station. For stations which have more than one frequency pair, you
might add a suffix to the station name. For example, station name FURUNO followed by -1,
-2, -3, etc. for each frequency pair required.

Procedure

1. Press function key F5 followed by the [1] key. The STATION ENTRY screen appears on
the CRT.

Station Entry
——— Station List
Create
Change
Station Set Up
[ Station MM |
ID Code :
Mode ¢ ARQ FEC DIRC CW
CH/Table : Channel ScanTable
Num/Table:

Fig. 3-6 Station Entry Screen

2. On the right-hand side on the screen you should see CREATE and CHANGE, and
CREATE will be underlined. If not, place underline below CREATE by pressing [»], [ ]
and ENTER in that order.

3. The cursor is on the STATION line. Enter station name, up to 20 characters.

4. Press the [ { ] key to go to the ID CODE line. Enter station ID code. (Currently ship station
IDs have five digits and coast stations have four. In the future both will have nine.)

5. Press the [ | ] key to go to the MODE line. MODE appears in inverse video. Use the [~]
key to select communication mode. Each time the key is pressed the communication
mode changes in the sequence of ARQ, FEC, DIRC and CW.

ARQ........... automatic retransmission request
FEC............ forward error correction

DIRC .......... direct FSK (five unit code, no error correction)
CW........ Morse code
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10.

11.

12.

. Press the [ | ] key to go to the CH/TABLE line. CHANNEL appears in inverse video.

If you want to select the SCAN TABLE, press the [~] key.

. Press the [ | ] key to go to the NUM/TABLE line.

. Enter channel number {ITU channel number or user channel number registered (See

page 3-11)]. If you select the SCAN TABLE, press the space bar to display the scan group
list and select a desired scan group. (When calling a station, the station call is first done
about one minute on a TX frequency in the scan group. If there is no reply from the
station, TX frequency is automatically changed to next one to call the station again. Thus,
TX frequency is changed in order until connection is established.)

. Press the ENTER key. The prompt OK/CANCEL asks for verification of data.
ZREATE
CHAMGE CARMIEL

Fig. 3-7 OK/CANCEL Prompt

If the data are correct, press the ENTER key. (To cancel, place cursor on CANCEL by
pressing the [{] key, and then hit the ENTER key. Data entered are erased.) The station
name has been registered and appears in the STATION LIST.

To enter other stations, select CREATE again by pressing the [-] key followed by the
ENTER key. Repeat steps 3-10 for each station. Each newly entered station appears in the
STATION LIST.

To confifm the data registered, pressing the [{] key, view the station name and its
particulars in the STATION SET UP.

NOTE: If you enter a station which exists the indication STATION BY THAT NAME

ALREADY EXISTS appears. To view the contents of the station list, press any key
once to go to the previous screen. Then, check the data for correctness. To
change the data of an existing station;

Changing the Contents of a Station

L.

(o NNV, R RIS B NS

Press the [ | ] key to place the cursor on a station (name) you want to change the contents
in the STATION LIST.

. Press the [~+] key to select CHANGE (CHANGE appears in inverse video).

. Press the ENTER key. The cursor appears on the STATION line in the STATION SET UP.
. Use the [1] and [ { ] keys and the BACKSPACE to make corrections.

. Press the ENTER key. The prompt OK/CANCEL asks for verification of data.

. If the data are correct, press the ENTER key to terminate keyboard operation. The

last-entered station appears on the top line of the STATION LIST and its particulars
appear in the STATION SET UP window.
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Timer Operation

The DP-5 can transmit or receive a file, turning itself off and on at a predetermined time. Up
to 10 timer operations can be registered.

Procedure

1. Press function key Fs. Select TIMER OPERATION ENTRY by the [2] key. The screen
should look something like Fig. 3-8.

Timer Operation Entry

—Timer Operation List

Create
Change

Timer Operation Set Up

Operation N |

Station :

Start Time : 0: 0: 0 -
Stop Time :+ 0: 0: 0 Main
Receive/Send : Receive Send Disk

File to send

Fig. 3-8 Timer Operation Entry Screen

* At this time, if one or more timer-operation name has been registered, the "Change" is
underlined. Press [~} and [ 1] keys in that order, then the "Create" is underlined.

2. Enter a suitable operation name on the OPERATION line. All alphanumeric characters
are valid. See note 2.

3. Place the cursor on the STATION line. Press the space bar, then the Station List
(described at the previous section) appears. Select a desired station by pressing the [{]
key followed by the ENTER key. Then the station name selected is listed at the Timer
Operation Set Up.




Timer Operation PREPARATIONS

4. Press the [ {] key to advance the cursor to the START TIME line. Enter start time, the
time the operation is to begin, using 24-hour notation. To have the set turn on at 8:35, for
example, the keying sequence would be;

8 - 3 5

5. Press the [ | ] key to advance the cursor to the STOP TIME line. Enter stop time, the time
the operation is to end.

6. Press the [ | ] key to advance the cursor to the RECEIVE/SEND line. Select receive or
send.

7. For send, designate the file to be sent. Press the [ | ] key to advance the cursor to the FILE
TO SEND line. To enter a file name, press the space bar to display the file list and select
a desired file name followed by the ENTER key.

* Before selecting a desired file, if necessary, designate the location of the file. For floppy
disk, press the [~] and [} ] keys followed by the ENTER key. (DISK is underlined.)

8. When all timer operation data are entered, press the ENTER key. The prompt OK/CAN-
CEL asks for verification of data.

9.1f the data is correct, press the ENTER key to terminate keyboard operation. The operation
name appears in the TIMER OPERATION LIST. See note 2 and 3.

10. To enter another timer operation, press the [»] key to change the CREATE to inverse
video, followed by the ENTER key. OPERATION of TIMER OPERATION SET UP
appears in inverse video, indicating you may enter data. Repeat steps 2 to 9 for each timer
operation parameter.

NOTE: 1) To alter a timer operation, select it on the TIMER OPERATION LIST, and then
press the arrow keys followed by the ENTER key (CHANGE is underlined and
OPERATION appears in inverse video). Enter new data.

2) If the same operation name which is already registered is entered, the
following alarm indication appears.
OPERATION NAME ALREADY EXISTS.
PRESS ANY KEY TO ESCAPE.
At this time, press any key and change the operation name.

3) If the station name which is not registered at the STATION ENTRY is entered,
the following alarm indication appears.
STATION BY THAT NAME DOES NOT EXIT.
PRESS ANY KEY TO ESCAPE.
At this time, press any key and re-enter the station name correctly.
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Frequency Scanning

The DP-5 can automatically control radio equipment through frequency scanning. The radio
equipment scans a number of frequencies (according to your selection), stopping when your
own ID code is detected in an incoming signal. The transmitter is tuned to the corresponding
transmitter frequency, the communication link is established and the traffic is automatically
exchanged. Scanning resumes once the link is disconnected.

You may store a maximum of 10 groups/20 channels per group. Remember that frequency
scanning is possible only in the ARQ and FEC modes.

Procedure

1. Press function key Fs. Select SCAN ENTRY by pressing the [3] key. The SCAN ENTRY
screen appears.

Scan Entry
—Scanning Group List
Create
Change

Scanning Set Up

Group Name : i

Ch Dwell Time: 2.7 sec (2.7-4.5 sec)
Auto Search : OFF ON

No Channel Rx Freq Tx Freq Pass/Scan

1 0.00 0.00 Pass/Scan
2 0.00 0.00 Pass/Scan
3 0.00 0.00 Pass/Scan
4 0.00 0.00 Pass/Scan
5 0.00 0.00 Pass/Scan
36 0.00 0.00 Pass/Scan

Fig. 3-9 Scan Entry Screen

* At this time, if one or more scanning group has been registered, the "change" is underlined.
Press [+], [ 1] and ENTER keys in that order to register a new scanning group.

2. The cursor is on the GROUP NAME line, where you may enter group name.

3. Press the [ ] key to advance the cursor to the CH DWELL TIME line. Enter channel
dwell time in seconds. The dwell time is the time the receiver waits on each channel before
it selects the next frequency.

4. Press the [|] key to advance the cursor to AUTO SEARCH. To have your radio
equipment stop scanning when it finds the strongest signal (highest /N ratio), select
AUTO SEARCH ON. And to have it stop scanning on the first signal it finds, turn the
AUTO SEARCH OFF. The [~] and [«] keys turn AUTO SEARCH on and off,
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5. Advance the cursor to line no. 1 in the SCANNING SET UP window. Enter channel
number (ITU or user channels).

6. Press the [ | ] key to advance the cursor to line No. 2. Enter channel number. Repeat this
procedure to enter other channel numbers.

7. After entering all channels required, press the ENTER key.

8. The unit asks for verification of data. If the data are correct, press the ENTER key to save
the data. The scan group name entered appears in the SCANNING GROUP LIST.

9. To enter another scan group, press the [~] key followed by the ENTER key. Repeat steps
2-8 for each scan group.

NOTE: When the scan group memory is full the DP-5 displays SCAN GROUP INFORMA-
TION FULL.

Editing, Adding, Deleting, Disabling Scan Channels

General Procedure

1. Place the cursor on a group name in the SCANNING GROUP LIST. The particulars of
that scan group appear in the SCANNING SET UP window.

2. Press the [»] key to change CHANGE to inverse video, followed by the ENTER key.
3. Position the cursor on the line (channel) to be changed.

4. Do one of the below operations, and then press the ENTER key. A prompt asks you to verify
changes. If correct, press the ENTER key to terminate keyboard operation.

Editing

To edit channel number, hit the BACKSPACE key to delete the channel number. Then, enter
channel number.

To add a channel number enter it on a vacant line.

Deleting

To delete a channel number hit the BACKSPACE key until it disappears.
Disabling

To temporarily delete a channel from scanning, press the [«] key to underline PASS.
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Scramble Operation

The DP-3 can exchange enciphered information with another receiving station. Up to five
scramble groups can be entered.

Procedure

1. Press function key F5 followed by the [4] key to display SCRAMBLE CODE ENTRY
screen.

Scramble Code Entry

— Scramble Table List
Create
Change

Torantle Set Lip

[Tabie-ame JN-
Mo Mormal Scramble
Letter Figure Letter Figure

1 & - ] -

2 E 7 B 7

2 C : C :

4 D ® D B |

= E 3 E 3 |
1 = F F |
R 5 l

.
G)

Fig. 3-10 Scramble Code Entry Screen

* At this time, one or more Scramble Table has been registered, the "Change" is underlined.
Press the [-], [*] and ENTER key in that order to register a new scramble table.

2. Enter group name on the GROUP NAME line.

3. Press the [ | ] key to advance the cursor to "No. 1."

4. Using the [~] and [«] keys, select a scramble code combination.

5. Repeat steps 3 and 4 to select a scramble code for each letter of the alphabet.
6. Press the ENTER key. You are asked to verify data.

7. If the data are correct, press the ENTER key again. The GROUP NAME corresponding to
the scramble code entered appears in the SCRAMBLE GROUP LIST.

8. To enter another scramble group, press the [+] key followed by the ENTER key. Repeat
steps 2-7 for each group.
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User Channel

The user channel list provides storage for up to 100 user channels, numbered 0-99. Note that
user channels may be used in frequency scanning.

Procedure

1. Press function key F§ and then the [5] key. The USER CHANNEL ENTRY screen
appears.

—— User Channel Entry ——
rochannel List y ;

f Crzate

1

] Chanoe

— Channel Set Up —“"T

 ; |

Tx Freq : 0.eco 1

Rx Freq : ¢.oo :

i}

Fig. 3-11 User Channel Entry Screen

* At this time, one or more User Channel has been registered, the "Change" is underlined.
Press the [-], [ t] and ENTER key in that order to register a new User Channel.

2. Enter channel number on the CHANNEL line.

3. Advance the cursor to the TX FREQ line. Enter TX frequency.

4. Advance the cursor to the RX FREQ line. Enter RX frequency.

5. Press the ENTER key. A prompt asks for verification of data.

6. If correct, press the ENTER key. Channel number entered appears in the CHANNEL LIST.

7. To enter another user channel, press the [~] key followed by the ENTER key. Repeat steps
2 thru 6.

8. To alter user channels, place the cursor on the channel to be altered (in the CHANNEL
LIST). Select CHANGE by pressing the [-] key and the ENTER key. Then, make changes.
Press the ENTER key twice to terminate keyboard operation.
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Text Editor Parameters

The TEXT EDITOR screen is where you will compose and edit file messages. This screen
can be formatted according to your needs with the EDITOR menu.

Editor
Tab Width 248
Scroll Page Full Half
Screen Color Normal Inverse
Line No. OFF ON
Cursor Square Underline
Blinking Cursor OFF ON
No. Of Characters 69
No. Of Lines 60

Fig. 3-12 Editor Screen Parameters

Procedure

Press function key F7 to display the EDITOR screen. Use the cursor keys to select the
settings you require. After completion, press the ENTER key to terminate keyboard opera-
tion.

Menu Description

Tab Width Sets the quantity of character spaces between horizontal
tabs.
Scroll Sets how much the screen moves up over the page, when

the PAGE UP or PAGE DOWN keys are operated, in incre-
ments of page, full screen and half screen.

Screen Color Selects screen color; normal, white characters on black
background, or reverse, black characters on white back-
ground.

Line No. Turns the line number display on and off.

Cursor Selects cursor style; square block or underline.

Blinking Cursor Turning the blinking cursor item on causes the cursor to
blink.

No. of Characters Indicates the number of characters per line.

No. of Lines Indicates the number of lines per page.
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CREATING AND
EDITING FILES

General

This chapter describes how to create new text files, update existing files, delete, move and
edit text, search for a word in a file, replace every occurrence of a word or phrase with
another word or phrase, and printing.

Creating a File

You will create files on the text editor screen, which provides a complete line of editing
facilities.

Procedure

1. Press function key F1 to display the FILE Menu. Fig. 4-1 shows the FILE menu.

e el o B -
1: New Alt-N
2: Open Alt-0
3: Close A1t-Q
4: Delete Alt-D
5: Save Alt-S

7: Real Time Printing Alt-P
8: File to Print
9: Cancel Printing

0: Clear Buffer

Fig. 4-1 File Menu

2. Press the ENTER key or the [1] key. The default screen for file making (UNTITLED 1 or
UNTITLED 2) appears.

3. Type your message as you would with an ordinary typewriter or word processor.

Note: Do not use small letters, #, &, * $ and % for message text. Do not put "$$$" (three
successive $’s) in the middle of a sending message, but at the end. The
communication line is automatically disconnected when the DP-5 detects this
string.
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Saving a File

You can save a file to the main memory or a floppy disk. The main memory is useful for
automatic storage of incoming files and holding files which will be sent through automatic
operation; but its storage capacity is limited (100,000 characters). The floppy disk, however,
can store 720,000 characters.

To save a file to a floppy disk the disk must be formatted. Formatting prepares the disk so
information can be written onto its surface. You have to format a disk only once. You can
reformat a disk you have used before, however, in which case all prior information on the
disk is erased.

Formatting a Floppy Disk

Procedure

1. Press function key F1 to display the FILE menu.

2. Press the [6] key. The message PLACE FD FOR FORMATTING. PRESS ENTER KEY
TO START appears on the CRT. Insert a floppy disk to be formatted.

3. Press the ENTER key.

4. The prompt YES/NO asks you if you want to format the disk. Press the ENTER key to begin
formatting, or press the [ | ] key to escape.

5. When formatting is completed, FORMATTING COMPLETED appears on the CRT.

6. To format another disk, remove the just formatted disk. Insert a new disk and press the
ENTER key.
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Saving and Closing a File

You can save a file two ways: Save it without losing your place on the screen (called "save"),

or save it before clearing the screen or exiting (called "close").

Saving

1. Press function key F1 to display the FILE menu.

2. Press the [5] key. The screen should look something like Fig. 4-2.

* Instead of the procedures of 1 and 2 above, press the [S] key holding down the ALT key,
then Save Screen as shown below appears.

Saving File Name

(Untitled 1)

Save

Media

Main

Disk

Fig. 4-2 Save Screen

3. To store to the main memory enter a file name, up to eight characters.

You may use any letters or numbers on the keyboard. But you may not use the following

punctuation symbols;

| e " > <

’

To store to a floppy disk, press [~], [ 1] and ENTER keys in that order to underline DISK.

Enter the file name.

(Ex) FURUNO-1.TXT

(Max. 8

(It is better to enter extension name
to distinguish text file from macro file.)

characters)

4. Press the ENTER key. The message is saved to the memory or floppy disk without clearing

the screen.
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Closing
1. Press function key F1 to display the FILE menu.

2. Press the [3] key. The prompt FILE CLOSED, SAVE? appears on the screen.

3. To save the file, press the ENTER key. (If you do not need to save file, press [ ] followed
by the ENTER key.)

4. The remaining steps are the same as that for Save (on the previous page).

NOTE: Instead of the procedures of 1 and 2 above, press the [Q] key holding down the
[ALT] key then the prompt FILE CLOSED, SAVE? appears.

Opening and Closing a File

The main memory of this unit provides two working areas (called working area 1 and working
area 2) to which you can load a file; but only one file may be displayed on the CRT.

MEMORY

WORKING AREA (2) CRT
| >
one file DISPLAY
FILE 2 '

Fig. 4-3 Configuration of Main Memory

Opening
Procedure

1. Press function key F1 to display the FILE menu.
2. Press the [2] key. A chronological list of the files stored in the main memory appears.
3.If you want to sort the files by name, press [-+] twice, [ 1], and the ENTER key in that order.

4.Toview the contents of a floppy disk, press [+], [ { ], and the ENTER key in that order. If you
want to sort the files by name, press [-] twice, [ 1], and the ENTER key in that order.

5. Select a file by using the [ 1] and [ | ] keys. Press the ENTER key.
6. If the file has a password, enter the password and then press the ENTER key.

7. The contents of the file appear and the title bar shows the file name. You may repeat this
procedure to load another file into a working area.

4-4



Opening and Closing a File CREATING AND EDITING FILES

NOTE 1: When the working area is full, the message FILE CAN'T OPEN appears. Then,
you would close a file to clear a working area.

NOTE 2: Instead of the procedures of 1 and 2 above, press the [O] key holding down
the [ALT] key.

Closing

Procedure

1. Press function key F4 to display the WINDOW menu. The first and second lines show the
names of the files loaded in working areas 1 and 2.

Window

< FILE 1
< FILE 2

l

6: Remote A
7: Remote B

8: Distress Frequency Table

Fig. 4-4 Window Menu

2. Press function key F1 to display the FILE menu.

W

. Press the [3] key to display the file name of the working areas 1 and 2.

4. Select a file to be closed by using the [{] or [ 1] key. Press the ENTER key. The prompt
SAVE FILE? YES or NO appears on the screen.

5. To save the file, press the ENTER key. If you don’t need to save the file, press the [{ ] key
followed by the ENTER key.

6. To save the file, enter a file name and then press the ENTER key.

7. The first or second line of the WINDOW menu will now be blank, meaning the file has
been removed from a working area.
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Opening a file when working area full

When the working areas 1and 2 are loaded, if you press the [F1] key followed by the ENTER
key to open a new file, the following appears to indicate that a loaded file in the working
areas should be closed.

Open

Close a file to open
new file

1. ABCD
2. FURUNO

Select a file to be closed by using the [|] or [ 1] keys followed by the ENTER key.

Close
Save File?
(ABCD) No

To save the file, press the ENTER key. If you don’t need to save the file, press the [{] key
followed by the ENTER key.
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Saving a File Under a New Name

You may want to use a portion of an existing file in a new file, and save the file under a new
name.

Procedure

1. Call up afile.

2. Edit the file.

3. Press function key F1.

4. Then, press the [3] key (to clear the screen) or [S] key (to keep your place on the screen).

5. The prompt FILE ALREADY EXIST, OK TO OVERWRITE appears on the screen. To
save the file under its original name, press the ENTER key.

6. To store the file under a new name, select NO. Press the BACKSPACE key to erase the
original name and then enter a new name.

7. Press the ENTER key.

8. If you want to confirm that the file was saved under a new name, press Ft and [2] in that
order to view the OPEN screen.
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Printing a File

You can print out a file stored in the memory or a floppy disk or the contents of the paste
buffer.

Procedure

1. Press function key F1.

2. Press the [8] key. The display should look something like Fig. 4-5.

Print
File Mams ( Main ) Size Date Media Zort
924 T FAA S S sl it i 1t b et Y5058 Main Mame
TELEX 1k 1990/04/02 20:32
MEDF 1k 1330-01-03 20:31 Lisk Date
D-5 1k 1290-01-02 20:20
File Count : 2 Memory 3k Used 87k Avairable

Fig. 4-5 Print Screen

3. If necessary, select a media (main memory or floppy disk) by arrow keys, and then press
the ENTER key.

4. To print, select a file list or file. Press the ENTER key.
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Real Time Printing

An incoming or outgoing message can be printed out while it is being received or trans-
mitted. This is called real time printing.

Procedure

1. Press function key F1 to display the FILE menu.

2. Press the [7] key to turn real time printing on. PRINT appears on the screen. Then, when
receiving or transmitting a message, at the same time it is printed.

3. To turn real time printing off, do steps 1 and 2. The PRINT disappears on the screen.

NOTE: Instead of the procedures of 1, 2 and 3 above, press the [P] key holding down
the ALT key. The real time printing alternating changes ON and OFF.

Deleting a File

Procedure

1. Press function key F1.

2. Press the [4] key. The screen should look something like the one in Fig. 4-6.

Delete
File Name ¢ Main ) GSize Date Media Sort
ey il ] K 1390w 01403 23R Main Mame
NEDF 1k 19300103 20:31
Do-%5 ik 1930-01-03 20:30 Disk Date
! File Count : 2 Memory Sk Used 97k Avairabls

Fig.4-6 Delete Screen

3. Select a file by pressing the [| ] or [ 1] key. Then, press the ENTER key. The prompt FILE
DELETE OK? asks you if you want to delete the file.
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4.To delete the file, press the ENTER key. (To cancel, press the [ | ] key followed by the ENTER
key.)

NOTE: Instead of the procedures of 1 and 2 above, press the [D] key holding down the
ALT key.

Text Editing

You can delete, move and copy text by using the CUT, COPY and PASTE functions in the
EDIT menu (function key F2). Note that this key functions only when a file is displayed.
Cursor Placement

The EDIT menu provides commands which let you place the cursor at the top, bottom, or
desired line of the current file.

COMMAND MEANING

Goto Top Places the cursor at the top line of the current file. (Same as the
HOME key.)

Goto Bottom Places the cursor on the last line of the current file. (Same as the
END key.)

Goto Line Places the cursor on the line desired. (Same as the ALT + L keys.)

Cutting and Pasting
Procedure

1. Place the cursor on the first character of the text to be cut.

2. Highlight the text to be cut by pressing and holding the SHIFT key while pressing the [-]
key. If you highlight text which you do not want to cut, press the [«] key to adjust the
highlight.

3. Press the F2 and [2] keys in that order (Instead of this method, the DELETE key is
operative.)

4. The highlighted text is cut and the remaining text is reformatted. If a mistake is made, you
can restore the text by immediately selecting UNDO in the EDIT menu.

To move text to a new location after it has been cut, place the cursor at the exact spot in the
message where the cut text is to start. When the text cursor is placed correctly, press the [4]
key in the EDIT menu (Instead of this method, the INSERT key is operative).
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Copying and Pasting
Procedure

1. Select the text to be copied (see step two of the previous procedure).

2. Press function key F2 and then press the [3] key. (Instead of this method, it is operative to
press the [C] key holding down the ALT key.)

3. Place the cursor at the exact spot on the message where the copied text is to start.

4. Press function key F2 and then [4] key.

Undo

If you are editing a file and you want it to look like it did when you started use the UNDO
feature to return the file to its most recent state. For example, you have cut text but want to
restore it. Then, you would select UNDO in EDIT menu to restore the text to its most recent
location. (Pressing the [X] key holding down the ALT key executes the same function of the
UNDO.)

Select All

At times you may want to select an entire file automatically. The SELECT ALL feature lets
you select an entire file without having to select it by highlighting it manually. This feature
can be useful when you want to combine files. The procedure below explains how to tack the
file loaded in working area 1 onto the end of the file loaded in working area 2.

Procedure

1. Load a file in working area 1 by pressing function key F4 followed by the ENTER key. The
file in working area appears.

2. Press function key F2 and then [5] key. (Instead of this method, the ALT key + [A] keys
are operative.)

3. The entire file appears in inverse video.
4. Press the [C] key holding down the ALT key. The file is placed in the paste buffer memory.

5. Press function key F4. To select the file loaded in working area 2, press the [2] key. The file
in the working area 2 appears on the display screen.

6. Place the cursor at the exact spot in the message where the text now in the paste buffer
memory is to start.

7. Press the INSERT key. The pasted text begins where the cursor is placed.
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Finding Text

The find feature lets you search for text in a forward or reverse direction.

Procedure

1. Press function key F2 and then the [6] key. The SEARCH screen appears. (Instead of this
method, the ALT + [F] keys are operative.)

|
Search B | Forward

| Reverse

Fig. 4-7 Search Screen

2. Type the word or code you want to find. Select FORWARD or REVERSE to search the
file in a forward or reverse direction respectively from the cursor position. Press the ENTER
key to begin the search.

3. When the unit finds the word, the cursor stops at the first character of the word.

4. Press the ENTER key to continue the search.




Replacing Text

CREATING AND EDITING FILES

Replacing Text

The replace feature helps you replace every occurrence of a word or phrase with another

word or phrase in a file.

Procedure

1. Press function key F2 and then the [7] key. (Instead of this method, it is operative to press
the [R] key holding down the ALT key.)

2. The REPLACE screen appears.

Search - B

Replace With

Replace

Forward i

Reverse

Fig. 4-8 Replace Screen

3. Type the word you want to replace (SEARCH).

4. Hit the [{] key. Type the new word (REPLACE WITH). Select FORWARD or
REVERSE to search the file in a forward or reverse direction respectively from the cursor
position. Press the ENTER key to execute the replacement. The unit searches for the
"SEARCH" word forward or reverse from the cursor position and replaces it with the

"REPLACE WITH" word.
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Communication Record (Logging)

Transmission/Reception date, time, ID, mode, TX/RX frequencies and station name are
recorded each communication and stored in the main memory. See the Fig. below.

To see these data;

1. Press function key F1 and then the [2] key. (Or press the [O] key holding down the ALT
key.)

2. A list of the files stored in the main memory appears.

3. Select LOG FILE by pressing the [{ ] key and then press the ENTER key. The communica-
tion record appears.

Note: You can print out the communication record by selecting LOG FILE on the print
screen.

Note: The LOG FILE can store about 230 communication records. When the FILE is full,
an error message appears to alert you. If this occurs, delete all communication
records. (Before deleting the records, print them out or store with another file
name if required.)

Open
File Mame ( Main ) 3Size Dat= Media ort
ZLDG“FIEE-mu«&ww>%th«iknisgﬂélﬂxue& Main Mame
TELEX 1k 19900103 20:22
NEDF 1k 1990-01-03 20:21 Disk Liate
I po-s 1k 1990-01-02 20:30
File Count : 4 Memory 4k Used 98k Avairable
- LOG FILE
E Date Time ID  Mode Tx Freq. RX Freq. Station Mame
10-08 14:17 14:19 1234 FEC B87&S.00 £365.00 CHOUSH! -8M
10-08 14:19 14:20 1234 FEC E£7eZ.00 £%955.00 CHOUSHI-2M
10-08 14:20 14:23 1234 FEC &87&S.00 ESES.00 CHOUSH!-8M

Fig. 4-9 Log File
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Printing Communication Buffer

When Tx/Rx MSG Save is set to OFF (see page 10-5), all messages received are entered to
the communnication buffer.

To print out a contents of the communication buffer;

1. Press the PAGE UP or PAGE DOWN key to display the contents of the communication
buffer.

2. Locate the cursor to the position where you want to initiate print out.

3. Press the arrow key while holding down the SHIFT key so taht the part you want to print
out appears in inverse video.

4. Press the [C] key, holding down the ALT key to execute "COPY".
The text pointed out in above procedure is entered to the paste buffer.

5. Press the [F4] key and [3] key so that the content of the paste buffer appears.

6. Press the ENTER key so that the designated part of the communication buffer is printed
out.

4-15



TRANSMITTING AND
RECEIVING

General

This section shows you how to transmit and receive in the standard radiotelex modes ARQ
and FEC, radiotelegraphy CW and direct frequency shift keying DIRC. Also included are
the procedures for frequency scanning, scramble operation, and automatic operation.

Manual Calling

The simplest way to communicate with a desired party is described here. It is called “Manual
Calling.”

When ACTIVE FILE AUTO SEND is ON (refer to page 10-6), a message edited on the
screen will be transmitted as followed;

Procedure

1. Edit a message.

2. Press function key [F3] to display the OPERATE menu.

Operate

1l: Call Station

2: Macro Operation

3: File to Send
4: Cancel Sending

0: Manual Calling
A: Set Frequency

Fig. 5-1 Operate Menu
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3. Press the [A] key. The following appears.

Set Frequency
Tx Freg: .00
Rx Fregq: 0 .00

Fig. 5-2 Set Frequency Screen

4. Input a pair of communication frequency. This can be made only for Furuno transceiver
connected.

5. Press the ENTER key.

* For other maker’s transceiver connected, set a pair of frequency at the transceiver, instead
of the above procedure 2, 3 and 4.

6. Press the function key [F3] again and then the [0] key. The following appears.

— Manual Calling

WY : %) FeC DIRC CW
ID

Fig. 5-3 Manual Calling Screen

7. Select the communication mode. The ARQ appears in inverse video. If the other mode is
required, press the [=] key, so that a desired mode appears in inverse video.

8. Press the [ { ] key and input a ID number of party.
9. Press the ENTER key. Then the line will be connected a short while.

10. When a message edited is displayed on the screen, it is transmitted immediately (after
automatically exchanging the WRU and HR code for the ARQ mode).

In the FEC mode, press the ENTER key, then the edited message is transmitted.

11. When a message is not edited, you can directly type a message after manually exchanging
the WRU ([F9]) and HR ([F10]) code for the ARQ mode).

12. To disconnect the communication line, press the [F12] key.
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Calling a Station

Procedure

1. Press function key F3 to display the OPERATE menu.

Operate

1: Call Station

2: Macro Operation

3: File to Send
4: Cancel Sending

0: Manual Calling
A: Set Frequency

Fig. 5-4 Operate Menu

2. Press the [1] or ENTER key. The STATION LIST appears on the CRT.
3. Select the station you wish to call by pressing the [ | ] key.

4. Press the ENTER key to establish connection with the station.

File Edit Operate Window Station Terminal Editor System WRU HR Over Break
e 1990-10-08 14:28  (JST)----- Caps

Station Name t  NAGASAKI-8M :
Frequency (T/R) : B8765.00 / 8965.00 (kHz) Comm Mode : ARQ
Comm Status : Error Mark Space

Sending Volume : 100 (%) ARQ Error : O ARQ Time : O (sec)

Fig. 5-5 Communication Status Display

CONNECT appears in inverse video on the COMM STATUS line when an acknowledge
signal from the station called is detected. (In the ARQ mode connection may be delayed due
to signal condition. In the FEC mode, however, inverted display of CONNECT appears several
second later since the acknowledge signal is not required.)

5. When ACTIVE FILE AUTO SEND is set to ON (refer to page 10-6), the message
dislayed on the screen is transmitted immediately. If it is set to OFF, follow the next
section.
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Transmitting a File Message from the Memory or a
Floppy Disk

You may send a message file that you have stored in the main memory or a floppy disk.
Execute the below procedure after calling a station.

Procedure

1. Connecting the line, press function key F3 and then [3] key.

2. The SEND screen appears.

Send
File Mame ( Main ) Size Dats Madia Sort
CPAS e BUBFRR. et T T e e UL Main Mame
LOG FILE 1k 19901008 14:23
TELEX 1k 199001703 20:32 Disk Date
MNMEDP 1k 19%0/01-02 20:21
bo-< 1k 19900103 20:30
File Count : 4 Memaory 2 4Kk Used 9Bk Avairatle

Fig. 5-6 Send Screen

3. Select the file you wish to send by using the [ | ] key. Then, press the ENTER key to transmit
the file. ‘~

Stopping a Message During Transmission

Procedure

1. Press function key F3 and then the [4] key.

2. SEND CANCELED appears on the screen. The sending message stops but the line is still
connected.
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Selecting Reception Mode

Procedure

1. Press function key F3 and then the [6] key.

2. Using the left and right arrow keys, select reception mode.

AUTO......... Automatic operation in radiotelex modes ARQ and FEC
ARQ .......... International radiotelex ARQ mode

FEC............ International radiotelex FEC mode

DIRC .......... Direct FSK

3. Press the ENTER key. The reception mode appears on the screen.

All messages received are entered to the communication buffer. When REAL TIME
PRINTING is ON (refer to page 2-8), messages received are printed out on real time. If it is
set to OFF, these are referred on the communication buffer. The PAGE UP and PAGE
DOWN key are used to view the contents of the buffer.

When Tx/Rx MSG SAVE is set to MAIN or DISK, messages received are stored in the main
memory or floppy disk. These are recalled at OPEN screen, attaching a file name as LOGO1,
LOGO2....
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ARQ Operation

In ARQ operation one station (information sending station) sends data to another in block
by block, then listens the acknowledge signal between blocks from the information receiving
station which requests either the next block or retransmission of the last block if there is
error. The request may be repeated up to 32 times, until the complete block is received free
of error.

Procedure

1. Press function key F3 and then press the ENTER key. The CALL STATION menu appears.

File EditiMEatyTsli ndow Station Terminal Editor System WRU HR Over Break

————————————————————————————————————————————— 1990-10-08 14:41:08 (JST)---- Caps
Station Name t CHOUSH! -8M
gr‘ Call Station
o . .
ce | [—— Station List Station Set Up
_____ NAGASAKI-4M Station : CHOUSHI-4M
NAGASAKI-6M ID Code : 45678
NAGASAKI-12M Mode ! ARQ FEC DIRC CW
NAGASAKI-SM CH/Table : Channel ScanTable
FURUNO Num/Table :

Fig. 5-7 Station Call Menu

2. Select a station which you wish to connect (must be registered for the ARQ mode). Then,
press the ENTER key. The message CALLING STATION appears.

If the following message appears, check the power of a radio connected and interconnec-
tions between the radio and the DP-5.

Station calling suspended. Check radio and interconnections.

Press any key to escape.

3. When an acknowledge signal is detected, CONNECT at the communication status display
area lights in inverse video (see Fig. 5-9).

If signal conditions are poor connection may take a while. If the connection does not succeed
after elapsing one minute, the calling stops and CALLING FAILED is indicated. At this
time, try the step 2 again one ninute later. Should signal conditions worsen during message
transmission, ERROR appears in inverse video and 30 seconds later the line is disconnected.

4. When a message for transmission is displayed on the screen, the WRU code, HR code
and the message just compiled is automatically sent immediately after calling and estab-
lishing a connection with the other station.
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S. To send a message from a file, first press function key F9 (WRU) to receive the
answerback code of the other station. Verify that the code is correct from the station
called.

6. Press function key F10 (HR) to transmit your own identity (answerback).
7. You may now transmit a file stored in the main memory or a floppy disk. Press function

key F3 and then the [3] key to open SEND screen. Select a file to send and press ENTER
key. SEND appears in inverse video while the file is being transmitted.

Sand
File Mame ( Main ) Size Date Media Sort
LOG.FILE 1K 1990-,106/08 14:23 Main Nzme
TELEX 1k 1990-01-,03 20:32
MEDP 1k 1990-01-02 20:21 Tisk Date
DO-% 1k 1920-,01-03 20:30 R
File Count : 4 Mamory ¢ 4Kk Used 9Bk Avairable

Fig. 5-8 Send Screen

Further, the SENDING VOLUME indication, showing percentage of message transmitted,
counts upward as the message is being transmitted. ARQ error count and ARQ transmission
time are also shown.

File Edit Operate Window Station Terminal Editor System WRU HR Over Break
Bttt 1990-10-08 14:28  (JST)----- Caps
Station Name :  NAGASAKI-8M
Frequency (T/R) : _8765.00 / 8965.00 (kHz) Comm Mode : ARQ
Comm Status : Error Mark Space
Sending Volume : 100 (%) ARQ Error : 0 ARQ Time : 0 {sec)

Fig. 5-9 Communication Status Display

8. To change direction of traffic, press either function key F11 (OVER), or [+] and [?].
Then, the other station becomes the information sending station, your station the infor-
mation receiving station.

9. Receive a message from the sending station, if any.

10. After completion of communication, press the F9 (WRU) key to receive the answerback
code of the other station and then press the F10 (HR) key to transmit your own answer-
back code.

11. Press function key F12 (BREAK) to disconnect the line.
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Communication example

This section shows how to register your station with a coast station (Singapore), in order to
connect with a land line and send messages to other stations.

Contact the coast station following the procedure on page 5-3. Then, register your station’s
name, call sign, answerback code and selcall number and AAIC with the coast station.

You can call the Singapore coast station on ITU channels 809, 821 or 1201 (other channels
may also be used). Use communication mode ARQ. The Singapore coast station ID no. is
4620.

Registration procedure

1. Call Singapore coast station following the procedure on page 5-3.
2. Singapore requests your AAIC.
3. Type your AAIC.

4. Singapore asks for your callsign. Send your station’s name, callsign, answerback code and
selcall number.

S. Singapore sends time required to register your station.

6. Transmit end code.

9VG SERADIO RS

khkkkk kkkk k

kkkkk kkkk &

9VG SERADIO RS
MOM

F

UGOX DE 9VG RGR GA X X PSE SUPPLY YOUR AAIC HW +?—— Singapore requests your AAIC.

J Exchange answerback codes

Call operator.

OPR +
AAIC **01+7

RGR PSE GIVE YOUR SHIP NAME CALLSG! CALLSIGN HW +?

I INTRODUCE MY iNFO LATER _ . .
PLS AGAIN Singapore requests your station’s name and callsign.

X2 5.2 2 4

CS- ****X
ANSWERBACK CODE-***** ¥¥%x ¥
AAIC_****
SELCALL-*****
OK HW +7?
PSE BE SURE W ICH AAIC CFM PSE HW +?

**01 SO+ +7?

RGR PSE OFF TX X HERE EEE CALL BACK 2MINS TIME X HERE WILL
INPUT YOUR DATA

CUBIHW +2

OK TKS BI BI

Enter your stations name, callsign, answerback,
code and selcall number.

Time required to register your station
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Transmitting message directly (DIRTLX)

The procedure which follows shows how to transmit a Telex message directly to a station.
1. Execute "Calling a Station" on page 5-3.
2. After GA + and DIRTLX appear on your display, type Receiving station’s Telex number.
3. Singapore coast station sends its Telex number. Type receiving station’s answerback code.
4. Type MSG +7?
5. Type your message.

6. Type WRU. Receiving station and your station mutually exchange answerback codes
automatically.

7. Type KKKK (end code) at end of message. Your answerback code, receiving station’s
Telex number and communication time appear on your display.

8. Receiving station sends GA + 7.

To send another message by DIRTLX, start at step 2. To finish, type BRK +

— Exchange answerback codes
9VG SERADIO RS 55908 UGOX X After GA + appears type Receiving station’s

GA+7?

DIRTLX07205644325 =+ — Telex number. . _
TRY AGAIN OR USE "OPR’ If there is a mistake in the number coast station
GA+ ?EX asks you to reenter number.
DIRTLEX07205644325 + S et atiAm]

MOMO07205644325 +\ Receiving station’s Telex no.

fﬂs;ga‘fls)FURUNo J Type receiving station’s answerback code.

s s Prepare to send message.

TO FURUNO

THIS IS A TEST MESSAGE FROM ** *x*xxx %xkx IN KOBE. Type message.

WRU

5644325FURUNO J +7?

kkdkkk Rkkk *

KKKK End code. Your ship’s answerback code, receiving station’s
55908 UGOX X Telex no. and communication time appear.

9VG SERADIO RS

TIME: 29. 5. 96 7:49
SHIP: 555908 UGOX X
SUBSCR:07205644325 +

gg’iA ,,TION:1'4MIN BRK + disconnects the communication line.
BRK + // To send another message type DIRTLX instead of BRK +.




TRANSMITTING AND RECEIVING Communication example

Table of Abbreviations

Abbreviation |Question Answer or Advice

QRA What is the name of your station? The name of my stationis - - - -.

QRC By what private enterprise are the The accounts for my station are settled
accounts for charges for your station  |by the private enterprise - - - - .
settled?

QRU Have you anything for me? I have nothing for you.

QRV Are you ready? I am ready.

QRX When will you call me again? | will call you again at - - - - hours [on

-+ kHz].

QSsJ What is the charge to be collected to  [The charge to be collected to - - - -

ccincluding your internal charge? including my internal charge is - - - -
francs.

QSsL Can you acknowledge receipt? | can acknowledge receipt.

QSX Will you listen to - - - - [call sign] on I am listening to - - - - [call sign] on

QTC How many messages have you to | have - - - - message for you.
send?

QTu What are the hours your station is My station is open from ----to - - -+
open? hours.

Abbreviation |Definition

BK Signal used to interrupt a transmission progress.

CFM Confirm

DE "From ----"

K Invitation to transmit.

NIL I have nothing to send to you.

NW Now

PSE Please

R Received

REF Referenceto ----.

SvC Prefix indicating a service telegram.

Command and Abbreviation

Command Function

TGM + To indicate that the following message is a radiotelegram.

MSG + To indicate that the ship station needs to be connected immediately any message held.

OPR + Call operator.

URG + Safety, urgency and distress message.

MED + Request medical advice.

TEST + Request coast station to send a test message for checking the ship station

BRK + To clear the connection with the coast station.

Abbreviation

GA+ I am ready. Transmit your command.

MOM Wait a moment.

MSG + Request pending messages from the shore.

KKKK Terminate a message.
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FEC Operation

The FEC method of error correction is used when there is more than one receiving station,
and no replies are required by the other station. Each message is sent twice, the characters
of the first message interleaved with those of the second. The receiving station thus has two
chances to receive each character correctly. If both characters are in error, an asterisk (*) is
printed.

Procedure
1. Press function key F3.
2. Press the ENTER key to display the CALL STATION menu.

3. Select a station which is registered for the FEC mode. Then, press the ENTER key.
CONNEUCT lights in inverse video.

4. When an editing message is displayed on the screen, it is transmitted by pressing the
ENTER key.

5. To transmit a file message stored in the main memory or a floppy disk, press function key
F3, and then [3] key to open SEND screen. Select a file to send and press the ENTER key
to transmit the message. SEND appears in inverse video while the message is being
transmitted.

6. After the message is transmitted, press function key F12 (BREAK) to disconnect the line.

Other Modes of Operation

cw

Morse converter automatically transmits Morse signals translated from stored messages in
the memory or floppy disk; a morse key is not required to transmit messages in morse code.

DIRC

This mode is for reception and transmission using direct Frequency Shift Keying (direct
FSK; five error code with no error correction).
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Other Modes of Operation

Procedure

1. Press F3 key to display OPERATE menu.

2. Press [6] to display MANUAL RECEPTION screen.

3. Press [] to select DIRC.
4. Press ENTER key.
5. Press F3 key to display OPERATE menu.

6. Press [9] to set HIGH TENSION on.
HT appears on the screen.

7. Press F3 to display OPERATE menu.

8. Press [1] to display the CALL STATION menu.

9. Select the station registered which is CW or DIRC mode.

10. Press ENTER key.

11. When an editing message is displayed on the screen, it is transmitted by pressing the

ENTER key.

12. To transmit a file message stored in the main memory or a floppy disk, press function key
F3, and then [3] key to open SEND screen. Select a file to send and press the ENTER key
to transmit the message. SEND appears in inverse video while the message is being

transmitted.

13. After the message is transmitted, press function key F12 (BREAK) to disconnect the line.
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Timer Operation

The DP-5 can automatically send or receive telex messages when the predetermined time
comes (See page 3-6).

Procedure
1. Press function key F3 to display the OPERATE menu.

2. Press the [7] key. The TIMER OPERATION LIST appears.

~Timer Operation

List-
L v ’

S e wesa

Fig. 5-10 Auto Operation List

3. Select the operation (name) you wish to execute. Press the ENTER key. An asterisk appears
beside the operation selected. At the same time, the T.OP appears in inverse video at the
communication status display area (see fig. 5-14). If a floppy disk-stored file is to be sent, be
sure the floppy disk containing the file is inserted in the floppy disk drive.

4. Select another operation (name) if desired as the same way.

5. Press the ESC key.

6. When the predetermine time comes, the DP-5 automatically send or receive messages.

The results of timer operation are displayed as either OK or NG at the Timer Operation
List.

Timer Operation List
1
2
*3 0K
*0P4 0K
*x0P5 NG

Fig. 5-11 Timer Operation List

7. To stop timer operation;

a) Press function key F3.

b) Press the [7] key.

¢) Select the operation (name) which an asterisk is attached and then press the ENTER
key. Remove the all asterisks then the timer operation is cancelled.

5-13
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Scramble Operation

The DP-5 can be operated in the scramble (crypto) mode, exchanging enciphered informa-
tion with a receiving station.

Procedure

1. Press function key F3 to display the OPERATE menu.

2. Press the [8] key. The SCRAMBLE TABLE LIST appears.
Scramble Table List

E—

Fig. 5-12 Scramble Table List

3. Select a scramble group by using the [ | ] key. And then press the ENTER key. The SCRA
appears in inverse video at the communication status display area (See Fig. 5-14).

Your message will be transmitted and encrypted as designated on the scramble code
menu. Therefore the scramble code of the station which is to receive the message must be
in agreement with your own.

4. To stop an encrypted message;
a) Press function key F3.

b) Press the [8] key.
¢) The SCRA disappears and the scramble operation stops.

Transmitter High Tension Control

The transmitter high tension of a Furuno make radio which has the high tension control at
operation panel can be switched on and off from the keyboard at the DIRC and CW mode.

Procedure

1. Confirm that the communication mode is DIRC or CW at the communication status
display (See Fig. 5-14).

2. Press function key F3 and then the [9] key.
3. The HT in inverse video appears and the high tension is applied to the transmitter unit.

4. To switch off the transmitter high tension, do the same procedure above. The HT
disappears.
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Frequency Scanning

Radio equipment scans a group of operator-selected frequencies, and stops scanning when
an incoming signal is received.
Procedure

1. Press function key F3 and then the [4] key. The SCANNING GROUP LIST appears on
the screen.

Scanring Group List
1
z

3
Fig. 5-13 Scan Entry Screen

2. Select a scan group. Then, press the ENTER key.

3. The scanning starts and the indication SCAN appears in inverse video at the communica-
tion status display area. (The name of the scan group appears at the "Station Name".)

4. To stop scanning;

a) Press function key F3 and then the [4] key.
b) The scanning stops and the indication SCAN disappears.

File Edit Operate Window Station Terminal Editor System WRU HR Over Break

B e 1390-01-01 02:01  (JST)-———--==-=
Station Name  + SATRO_1 bera
Frequency (T/R) : 8344,00 / 8705.00 (kHz) Comm Mode : CW
Comm Status s+ Connect Send Lock Error Mark Space

Sending Volume : 100 (%) ARQ Error : 0 ARQ Time : O (sec)

Fig. 5-14 Communication Status Display
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WINDOW MENU

General

The WINDOW menu allows you to display one of the following together with the current
screen:

1) working file

2) contents of the paste buffer memory

3) Navigation data (CIF or NMEA format input data)
4) calendar

5) remote controller screen

6) distress frequencies

<FILE1 -
2:

< FILE 2

6: Remote A
7: Remote B

8: Distress Frequency Table

Fig. 6-1 Window Menu
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WINDOW MENU Window Menu Description

Window Menu Description

File 1/File 2

This menu selects which one of two opened files to display on the screen. Press function key
Fa. Press the [1] or [2] keys to select the file.

View Paste Buffer

This menu displays the contents of the paste buffer memory, which stores a text cut or copied
on the text editor.

Display CIF (NMEA) Data

When this unit is connected to a device which outputs data in CIF or NMEA format, that
data (for example, ship’s L/L position, speed and course) can be displayed on the CIF
(NMEA) screen. Press function key F4 and then press the [4] key. (CIF or NMEA is selected
at the TERMINAL menu.)

NTER
Lat/ton
Latituce Longi tude
Dk
OHERA
LA
LC
NNGS
DECCA
BFS
I
- Temperature -l —— Depth ——
— Ship's Speed —] — Heading —l

Data displayed depends on devices connected.

Fig. 6-2 CIF (NMEA) Screen
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CALENDAR

The calendar menu can display the calendar of any combination of month and year you
desire.

Press function key F4 and then the [5] key. Enter a month. Press the [ 1] key to advance the
cursor to the year location. Press the BACKSPACE key to place the cursor at the beginning of
the line and then enter (four digits) year desired.

Calendar
Year : 1990
Month :  1ff
1990. 10
Sun Mon Tue Wed Thu Fri Sat
1 2 2 4 =t &
7?7y 8 3 12 11 12 13
(14) 15 1€ 17 18 19 Z8
(1) 22 23 24 25 26 %
(28) 29 20 21

Fig. 6-3 Calendar

REMOTE A and REMOTE B

This menu permits remote control of a Furuno make transceiver, receiver or transmitter
connected to Terminal REMOTE A or REMOTE B. For further details, see the Service
Manual of DP-5 (Publication No. SM-E5520-0x).

Refnote

RV

TLDLLLILIDL

[ i ¢

A FRA4SETR
=
A

Fig. 6-4 Remote Screen
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Distress Frequency Table

This menu displays all current distress frequencies. Press function key F4 and then the [8]
key. The display should look something like the figure below.

Diztress Frequencies
Telephone (KHZ) : 2182.0 4125.0 6215.0 8291.0 12290.0 16420.0

Fig. 6-5 Distress Frequency Table Screen
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MARITEX

General

This chapter provides an overview to the MARITEX system. For further details, consult your
MARITEX Traffic Manual.

What is MARITEX?

MARITEX, an acronym meaning MARItime TEleX, is a worldwide, round- the-clock, fully
automatic and computerized network for maritime radiotelex. The MARITEX system is
operated jointly by the Telecom Administrations of Denmark, Finland, Iceland, Norway and
Sweden. The system consists of the Central Computer System in Gothenburg, Sweden, run
with two high technology computers, and sub-stations in Scandinavia, Panama, Manila, and
Argentina (begins operation September 1, 1992). The Central System does all the message
switching and co-ordinates the sub-station resources.

INTERNATIONAL
TELEX NETWORK REMOTE- PARTICIPATING
STORE-AND- CONTROLLED SHIPS
FORWARD | | RADIO CIRCUITS
SUB-STATION |_~#" ——,
DIRECT PANAMA
DIALING | |
MULTI ieanil SUBSTATION| 2 ———
ADDRESS SCANDINAVIA
SYSTEM
NETWORK SYSTEM MANILA
CONTROL
SEMI-FAX |—
SUB-STATION |_—% (———>
ARGENTINA

Fig. 7-1 MARITEX System and Services
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MARITEX What is MARITEX?

MARITEX Services
MARITEX provides four main services to MARITEX subscribers:

e Store-and-forward telex
e Direct dialing

o Multi address

e Semi-fax

NOTE: MARITEX provides both shore-to-ship and ship-to-shore services. This manual,
however, describes only the ship-to-shore communication procedures.




Preparation for Transmission MARITEX

Preparation for Transmission

To transmit a message in the MARITEX system, you will need to register three items:

e Answerback code
e Scan group
e Station name

Answerback Code

MARITEX assigns a Telex number to all MARITEX subscribers. This number functions as
answerback code. An answerback code contains the following:

00000 SHIP X

00000: MARITEX-assigned five digit Telex code
SHIP: Ship name
X: For shipboard station, normally X is input.

The procedure for registering answerback code is the same as which appears on page 3-2.
If an answerback code was registered before the commissioning of the MARITEX station a
new answerback code must be entered. To enter new answerback code, contact FURUNO
or authorized FURUNO agent or dealer.
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MARITEX Preparation for Transmission

Scan Group

The Central System emits a free-signal to indicate a MARITEX radio channel is in idle
condition and available for ship-to-shore calls. The free-signal is detected and recognized by
the shipboard equipment as a permission to start the transmission. Then, the shipboard
operator initiates a call.

You can scan search for the free-signal automatically by registering MARITEX radio
channels in scan group(s). The procedure for registering scan groups for MARITEX use is
the same as that which appears on page 3-8.

1. Press function key F5 to display the STATION menu.

2. Press [3] to select Scan Entry. The screen should look something like Fig. 7-2.

Scan Entry

Create

—Scanning Group List
—} Change

Scanning Set Up

Group Name EM |

Ch Dwell Time: 2.7 sec (2.7-4.5 sec)
Auto Search : OFF ON

No Channel Rx Freq Tx Freq Pass/Scan

1 0.00 0.00 Pass/Scan
2 0.00 0.00 Pass/Scan
3 0.00 0.00 Pass/Scan
4 0.00 0.00 Pass/Scan
5 0.00 0.00 Pass/Scan
36 0.00 0.00 Pass/Scan

Fig. 7-2 Scan Entry Screen

The top right-hand side box contains the words "Create" and "Change" and one is
underlined. If there are scan groups registered "Change" is underlined. Otherwise, "Cre-
ate" is underlined. If "Create" is not underlined, set the underline beneath it by pressing
[=],[*] and ENTER in that order.

3."Group Name" appears in inverse video, meaning you can enter scan group name. Enter
scan group name; for example, MARITEX-A.

4. Press the [{ ] key to advance the cursor to "Ch Dwell Time." The dwell times is the time
the receiver waits on each channel before it selects the next channel. The factory is setting
is 2.7 seconds. If you do not need to change dwell time, go to the next step.

5. Press the [ | ] key to advance the cursor to "Auto Search.” To have your radio equipment
stop scanning when it finds the strongest (S/N ratio) free-signal frequency, turn on Auto
Search. In the off setting, scanning starts and stops with the first-received free-signal
frequency. Adjust the underline by the arrow keys to select ON or OFF.
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Preparation for Transmission

MARITEX

6. Press [{] to place the cursor on the No.1 line. Enter scan group name; for example,
MARITEX-A. Then enter I'TU channel or user channel. Refer to Table 7-1 (on the next
page) for MARITEX radio channel information.

7. Press [ ] to advance the cursor to the "No.2" line. Enter channel number. Repeat this
procedure for other channels, up to 20.

8. Press ENTER.

9. Press ENTER again to register scan group.

~—Scanning Group List

MARITEX-A _]

Scan Entry

Create
Change

Group Name

Auto Search

No Channel
1 1

A WwN
AW

Scanning Set Up

MARITEX-A

Rx Freq
4268.60
6460.00
8556.00
12818.00
17024.00
22607.30

Ch Dwell Time: 2.7 sec (2.7-4.5 sec)

Pass/Scan
Pass/Scan
Pass/Scan
Pass/Scan
Pass/Scan
Pass/Scan
Pass/Scan

Fig. 7-3 Scan Entry Screen

10. To enter another scan group, press the right arrow key to select "Create" and press ENTER.
Repeat steps 3 through 8 above.
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Table 7-1 MARITEX Channels

ITU Channel | MARITEX No. | Coast Station TX (kHz) | Ship Station TX (kHz) Location
UP A7 2423.5 32675 SWEDEN
UpP B7 2716.0 2477.0 SWEDEN
UP D7 1905.0 2222.0 SWEDEN
upP At 4268.6 4203.5 SWEDEN
408 B1 42145 4176.5 SWEDEN
414 Ct 4216.5 4179.0 SWEDEN
upP A2 6460.0 6302.0 SWEDEN
601 B2 6314.5 6263.0 SWEDEN
619 C2 6323.0 6272.0 SWEDEN
upP A3 8556.0 8398.5 SWEDEN
807 B3 8419.5 8379.5 SWEDEN
824 C3 8428.0 8388.0 SWEDEN
upP A4 12818.0 12563.5 SWEDEN
1206 B4 12582.0 124795 SWEDEN
1224 C4 12581.0 12488.5 SWEDEN
UP A5 17024.0 16790.5 SWEDEN
1614 B5 16813.5 16690.0 SWEDEN
1664 Cs5 16838.0 16715.0 SWEDEN
1657 C7 16834.5 16711.5 SWEDEN
1605 D2 16809.0 16685.6 NORWAY
upP A6 22607.3 22352.0 SWEDEN
2207 B6 22379.5 22287.5 SWEDEN
2232 Cob 22392.0 22300.0 SWEDEN
2205 E7 22378.5 22286.5 NORWAY
817 D3 84245 8384.5 PANAMA
1208 D4 12583.0 12480.5 PANAMA
1633 D5 16822.5 16699.5 PANAMA
2231 D6 22391.5 22299.5 PANAMA
823 E3 8427.5 8387.5 PHILIPPINES
1215 E4 12586.5 12484.0 PHILIPPINES
1603 E5 16808.0 16684.5 PHILIPPINES
2213 E6 22382.5 22290.5 PHILIPPINES
840 F3 8436.0 8396.0 ARGENTINA
1250 F4 12604.0 12501.5 ARGENTINA
1621 F5 16817.0 16693.5 ARGENTINA
2240 F6 22396.0 22304.0 ARGENTINA

Valid from September 1, 1992
UP means no ITU channel assigned. You can use register these as user channels.
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Station Name

The next step is to enter station name. The procedure is the same as the procedure shown
on page 3-5. The station list provides abbreviated dialing with storage for up to 50 stations.

1.

[®]

Press function key F5 followed by ENTER or [1] key. The STATION ENTRY screen
appears.

Station Entry
—— Station List
Create
Change
—————— Station Set Up
:
ID Code :
Mode : ARQ FEC DIRC CW
CH/Table : Channel ScanTable
Num/Table:

Fig. 7-4 Station Entry Screen

. At the top right-hand side of the display, the underline is beneath “Create” or “Change.”

If “Create” is not underlined, set the underline beneath it by pressing [»], [1] and ENTER
in that order.

The cursor advances to the Station line. Enter station name, up to 20 characters; for
example, MARITEX.

. Press the [} ] key to go to the ID Code line. Enter station ID code; the coast station

selective call number common to all stations is 2950.

. Press the [ { ] key to go to the Mode line. MODE and ARQ appear in inverse video. The

MARITEX system uses ARQ mode.

.Press [} ] [=]toset the cursor on “Scantable.”

. Press [|]. “Num/Table” appears in inverse video and the message “Hit space key to

display the list” is displayed.
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7. Press the space bar. The Scanning Group List appears.

——— Scanning Group List —
MARITEX-A |
MARITEX-B
MARITEX-C
MARITEX-D
MARITEX-E
MARITEX-F

Fig. 7-5 Scanning Group List

8. Press [ ][ 1] to select scan group name. For example, select MARITEX-A.

9. Press ENTER. Then, the scan group entered is assigned MARITEX as station name and
2950 as ID number. To enter another station name, repeat the above procedure from step
2. To establish the connection with a maritex station,

Note: To establish the connection with a maritex station, the receiving frequencies in the
scan group registered are scanned to detect a free signal from the station. If the
free signal is detected, a message will be automatically transmitted to the station.
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Preparation of Program for Automatic Transmission

This section shows you how to prepare the programs necessary for automatic message
transmission. The programs, which you can save to the main memory or a floppy disk for
future use, enable unattended automatic transmission.

The program for automatic transmission is called macrofile. You will need several types of
macrofiles depending on the MARITEX service to be utilized.

Commands

The tables which follow describe the commands for automatic transmission.

o Table 7-2 describes the commands processed by the DP-5, and
® Tables 7-3 and 7-4 describe the commands processed by MARITEX stations.

Table 7-2 Commands Processed by the DP-5

Command (prefixed by @) Parameter Content
CALL S: Station Name | Calling station name and 1D on assigned
I: 1D parameter
FREE Two digits Free-signal searching time according to
(support command for CALL) 0—99 min. assigned parameter (factory setting: 10 min.)
RETRY Two digits Calling according to assigned parameter (factory
(support command for CALL) 0—99 min. setting: 10 min.)
CASE Text Used to receive a message (designated by
parameter) transmitted by a coast station.
TIMEOUT Two digits Time allotted for reception of message by CASE
(support command for CASE) 1—99 min. command.
SEND Text Text transmitted according to assigned
parameters.
M: File Name File transmitted according to assigned parameter
D: File Name (M: Main memory, D: floppy Disk)
WRU NONE Function keys F8—F12.
HR
OVER
BREAK
DISPLAY Text Text of message appears
INPUT NONE Waiting for keyboard input
Transmit keyboard input message




MARITEX Preparation of Program for Automatic Transmission

Table 7-3 shows the commands processed by MARITEX stations. After reception of
"GA + 7", enter appropriate short-code command.

Table 7-3 MARITEX Short-Code Commands

Command Usage

TLX ... + Store-and-forward Telex

DIRTLX ... + Direct dialing Telex

MULTI ... + Multi address

FAX ... + Semi-fax

MSG + To request pending messages from the shore
NNNN + To terminate a message

BRK+ To clear the radio circuit

Table 7-4 Other MARITEX Short-Code Commands

Command |Usage

POS + Transmission of ship position reports

URG + Safety, urgency and distress messages

MED + To request medical advice

LTR+ For MARITEX letters mailed from the Operations Center to destinations world wide
TST+ Request to MARITEX to send a test message consisting of all Telex characters
MRK + Request to MARITEX to send a continuous mark tone for 1 minute

NOTE: For other supporting and facility commands, consult the MARITEX Traffic Manual.
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MARITEX

Store-and-Forward Telex

The following is the sequence of events in transmission of Telex message in MARITEX.

1. Shipboard station sends message to MARITEX coast station.

2

w

4. MARITEX station sends message to subscriber designated.

No. Procedure

1 Call MARITEX.

. MARITEX coast station stores message in memory buffer.

Display on DP-5

CONNECT appears in

inverse video, and audible

bell signal sounds.

2 Transmit WRU signal. MARITEX S
26 X X X SHIP X
GA+"7?
3 Key in Telex number of
subscriber.
For example: (Hong Kong) 12345
TLX80212345 + - MSG+? |
i Transmit message file.
5 When message is transmitted 26 X X X SHIP X
completely, type NNNN. MARITEX S
DURATION
DATE
GA+?

6 Transmit BREAK command to
clear radio circuit.

. Shipboard station and MARITEX coast station clear the radio circuit.

Remarks

Free-signal found;
radio circuit ready.

initial identity
exchange between
coast station and
shipboard station.

Request to start
message transmission.

Message transmission

Transmit your
answerback code.
Receive MARITEX
station’s answerback
code.

Tx time and date
appear on DP-5.
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Procedure for preparing a macrofile for store-and-forward Telex

You will need a macrofile to enable automatic message transmission on store-and-forward
Telex. The procedure which follows shows you how to prepare a macrofile. After preparing
it, save it to main memory or a floppy disk for future use.

1. Press function key F1 to display the FILE menu.

2. Press [1] to display the text editor screen.

3. Make a program to send a message by automatic connection and transmission.

The figure below shows the minimum information required to send a store-and-forward
Telex message in MARITEX.

Untitled 1 ———I
@ FREE 10 N0,
@CALL S:MARITEX l @
@ WRU
@ CASE GA+?
@SEND TLX80212345+4 @
@ CASE MSG+?
@ SEND M:ABC @
@ SEND NNNN ~®
@ CASE GA+?
@ SEND BRK+

-

Free-signal search time (10 minutes)

*2 ) Station name (for example, MARITEX)
Who are you?

Station identity exchange

3 ' Subscriber’s Telex number (in example, 802 is country code for Hong Kong) for
_ store-and-forward mode

"4 Location and name of file message (M: Main memory, D: floppy Disk)

5 Request for termination of message

Fig. 7-6 Example Macrofile for Store-and-Forward Telex

4. Press function key F1 to display the File menu.
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5. Press [5]. The Save prompt appears on the display.

Save
Saving File Name Media
| Main
(Untitled 1) Disk

Fig. 7-7 Save Prompt

6. Enter a file name as follows.

O0000000. MCR
4 4

File Name Extension Name
(max. 8 characters)

7. You may save the file to either a floppy disk or the main memory. In the Media box on the
Save screen, place the underline under Main for main memory, or Disk for floppy disk.

8. Press ENTER to save file.
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MARITEX Preparation of Program for Automatic Transmission

Direct Dialing

The direct dialing features allows you to contact a land subscriber via MARITEX. Below is
an example of a macrofile to use when using the direct dialing feature.

ores s S o
@CALL S:MARITEX — eeeeennvnnnenn. UTUTR ®
@WRU

@CASE GA+?

@SEND DIRTLXT25644325+  «veevvnennennenernsnnenannnns ©)
@CASE MSG+7?

@SEND D:ABC e it s it e @
@SEND NNAN ..........@
@CASE GA+?

@SEND BRK+

- Free-signal search time (15 minutes)
Station name
Who are you?
~ Station identity exchange
3 Subscriber’s Telex number (in example, 72 is country code for Japan) for direct dialing
mode
Location and name of file message (M: Main memory, D: floppy Disk)
- Request for termination of message

(B —

Nl s

Fig. 7-8 Example Macrofile for Direct Dialing
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Preparation of Program for Automatic Transmission

MARITEX

Procedure

Call MARITEX.

Transmit WRU signal.

Key in Telex number of
subscriber.
For example: (Japan) 725644325

DIRTLX725644325 + |

Transmit prepared text file, or
input message manually through
keyboard.

When finished, type NNNN.

Transmit BREAK command to
clear radio circuit.

Display on DP-5

CONNECT appears in

inverse video, and audible

bell signal sounds.

MARITEX S
26 X X X SHiP X
GA+7?

12:20

MOM

5644325 FURUNO J
MSG +?

26 X X X SHIP X
5644325 FURUNO J
MARITEX S
DURATION

DATE

GA+7?

Remarks

Free-signal found;
radio circuit ready.

Initial identity
exchange between
coast station and
shipboard station.

Request to start
message transmission.

Message transmission

Transmit your
answerback code.
Receive MARITEX
station’s answerback
code.

Tx time and date
appear on DP-5.
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MARITEX Preparation of Program for Automatic Transmission

Multi Address

The figure which follows shows an example of a macrofile for multi address use.

@FREE 15 et a e @
@CALL S:MARITEX

@WRU

@CASE GA+?

@SEND MULTI+ e, ®
@CASE NUME? e e, ®

@SEND 725644375 e,
@SEND 80255785 eeeeeeeneeeieenaieaaaaaa.,
@SEND 5412345 e
@SEND 42124567+ e
@CASE MSG+?7
@SEND M:ABC  eeeeeeieeeeieeaeieaiaie ®
@SEND NNNN

@CASE GA+?

@ SEND BRK+

1: Free-signal search time (15 minutes)

2) Command for multi address message

Search for “NUM + ?” sent by MARITEX station

| Addresses of subscribers. Last address contains “ +” code.

' Location and name of message file (M: Main memory, D: floppy Disk)

i

U R —

{

Fig. 7-9 Example of Macrofile for use in Multi Address
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Preparation of Program for Automatic Transmission MARITEX

Semi-fax

In the Semi-fax option, MARITEX converts ship-to-shore direction telex message to facsim-
ile and retransmits it via the telephone network.

The figure below shows and example of a macrofile for use in Semi-fax. The macrofile for
Semi-fax is the same as the macrofile for store-and-forward and direct dialing except for the
FAX command.

@FREE 10

@CALL S:MARITEX
@WRU

@ CASE GA+?

@ SEND FAX802123456+ R LR TR PRI O
@ CASE MSG+?
@ SEND M:ABC
@ SEND NNNN
@ CASE GA+?

@ SEND BRK+

Fig. 7-10 Example of Macrofile for use in Semi-fax
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MARITEX Transmission of Telex in MARITEX System

Transmission of Telex in MARITEX System

This section describes how to transmit a message in MARITEX.

Preparation for Transmission

1. Register answerback code (Telex number assigned by MARITEX).
2. Register MARITEX frequency and channel to scan group.
3. Register station name including scan group name.

4. Retrieve suitable macrofile. Include station name and a message file name. Type message
and save file to memory.

5. Open macro operation menu and select macrofile. (See next page for details.)
Your message will be transmitted automatically. Below is the sequence of automatic Telex
message transmission.

1) Search for free-signal

2) Call MARITEX station on MARITEX radio channel.

3) After connection is established, identity exchange

4) Transmission of service category and subscriber’s address
5) Transmission of message

6) Transmission of "termination of message" signal

7) Identity exchange

8) Clearing of radio circuit




Transmission of Telex in MARITEX System

MARITEX

Actual Transmission

Below is the basic procedure for transmitting a prepared message in the MARITEX system.

1. Press F3 to display Operate menu, and then press [ | ] to select “Macro Operation”.

Operate
1: Call Station

2: Macro Operation

3: File to Send
4: Cancel Sending

0: Manual Calling
A: Set Frequency

Fig. 7-11 Operate Menu

2. Press [Enter]. The Call Macro screen appears.

File Name (Main)

MARITEX1. MCR
MARITEX2. MCR

File Count: 2

Call Macro
Size Date
1K 1992/06/10 11:20
1K 1992/06/10 12:30
Memory: 2K Used

Media Sort

Main

Name

Disk

Date

98K Available

Fig. 7-12 Call Macro Screen
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MARITEX Transmission of Telex in MARITEX System

3. Press [ | ] to select desired macrofile. The extension “MCR” indicates macrofile.

4. Press ENTER. The “Wait for Free Signal” indication appears. Your message will be
transmitted automatically.
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PRINTER
(optional supply)

Refer to operator’s manual of the printer PP-500.
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PRINTER (optional supply)

This page internationally left blank.




MAINTENANCE AND
TROUBLESHOOTING

Maintenance

The DP-5 provides many years of trouble-free performance provided it is properly installed
and maintained. To keep it operating in top condition you should establish a regular
maintenance program and it should include at least the following:

Cleaning of the CRT

Wipe of accumulated dust with a soft cloth. For stubborn dirt, an anti-static cleaner may be
used. Do not use solvents to clean the CRT. They may remove paint and markings.

Connectors & Earth Connection

Periodically check the connectors for proper seating and the earth connection for rust.
Remove rust to maintain a good ground system.

Floppy Disk Drive

Clean the floppy disk drive head regularly to prevent erasure of information stored on disks.

Troubleshooting

Power Supply

If the power cannot be applied (power lamp does not light):

1) Check for loosened power cable connector on the rear of the unit. Check that the ship’s
mains main switch is turned on. Confirm that power (10-40 VDC) is present at the
connector (pin #1: (+), pin #2: (-)).

2) Check the unit for tripped breaker. (The breaker is on the rear of the unit.) If it has
tripped, reset it.




MAINTENANCE AND TROUBLESHOOQTING

Self Test

This unit has several self-tests which check it for proper operation.

To call up the SELF TEST menu, press function key F8. Select CHANGE by pressing the
[=]key. And then select SELF TEST by pressing [ | ] key several times followed by pressing

the ENTER key. Fig. 9-1 shows page 1 and page 2 of the SELF TEST menu.

Procedure

Select a test by operating the up and down arrow keys followed by pressing the ENTER key.
You may terminate a self test anytime by pressing the ENTER key. Control is returned to the

self test menu.

When you execute all items, it takes about 15 minutes. It is sufficient to execute the items
marked * in Figure 9-1 for periodical check.

Self Test

Video RAM

ROM

EE-PROM

Rémote

Line

Tone Test 1(All Char)
Test 2(Fox)
Test 3(Beta)
Test 4(Mark)
Test 5(Space)
Test 6(By)

Monitor Beep
Line In
Line Out

Pressthe [|] and [1] keys
to scroll the menu.

FD Read/Write

Fig. 9-1 Self Test Menu




Self Test

MAINTENANCE AND TROUBLESHOOTING

MAIN RAM (Memory) Test

This test checks each bank of the Main RAM (in sequential order) for proper operation. The
result of each check is shown as OK (normal) or NG (No Good, error). When the check is
completed, MAIN RAM CHECK COMPLETED. PRESS ANY KEY TO ESCAPE ap-

pears on the CRT. You may press any key to return control to the self test menu.

File Edit Operate Window

0 Bank
2 Bank
4 Bank
& Bank
8 EBank
10 Bank
12 Bank
14 Rank

e T e e S = NP P

oooco
10000
20000
30000
40000
50000
€0000
?0000

07FFF
17FFF
27FFF
37FFF
47FFF
SYFFF
&7FFF
?7FFF

N N N Y A

Main RAM Check

Resulz®

§]

K

OK

0O0000Oo00

~

K
K

S a gy

O -1y W

o e
(OB

Station Terminal EditorSYaray

WRL HR ver Break

1990-10-08 1&:00 (JISTY-~-- Caps
Result
Bank ( 08000 OFFFF » O K
Bank ( 18000 AFFFF > O K  f[~=--~-
Bank ( 28000 2FFFF )} 0O K
Rank ( 38000 ZFFFF ) O K
Bank ( 48000 4FFFF ) 0O K
Bank ( 58000 SFFFF ) O K
Bank ¢ £8000 EFFFF 3} O K
RPank ( 78000 ?FFFF > 0O K

Main RAM Check completed.

Pregg any key to escape.

Fig. 9-2 MAIN RAM Test Screen
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MAINTENANCE AND TROUBLESHOOQOTING Self Test

VIDEO RAM Test

This test checks the Video RAM for proper operation. The unit checks the two banks of the
Video RAM in sequential order, displaying the result of the check as either OK (normal) or
NG (No Good, error). When the check is completed, VIDEO RAM CHECK COM-
PLETED appears on the CRT. You may press any key to return control to the self test menu.

File Edit Operate Window Station Terminal EditorSTTa WRU HR Over Break
--------------------------------------------- 1930-10-08 16:02 (JST)---- Caps
Station Mame

Video RAM Check
Result Result
0 Bank ( 80000 - S87FFF > O K 1 Bank ( 28000 - 8FFFF > O K

Video RAM Check completed. Press any key to escape.

Fig. 9-3 VIDEO RAM Test Screen
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Self Test MAINTENANCE AND TROUBLESHOOTING

ROM Test

You may check the ROM for proper operation. The result of the test is shown as OK or NG.
When the check is completed, ROM CHECK COMPLETED appears. Press any key to

return to the self-test menu.

File Edit Operate Window Station Terminal EditorJ ST WRU HR Over Break

--------------------------------------------- 1950-10-08 16:03 (JST)---- Caps
Station Mame
Frequency( T/R ) : s ( kHz >
Com———————— ROM Check or Mark Space
Sen 0 ARG Time : 0 ( sec

------ Check Sum Value : EDES ¢ EDES > (O K [-==-----==-=--=-=swo-oooooeom oo

ROM Check completed. Press any key to escape.

Fig. 9-4 ROM Test Screen

EE-PROM Test

The check of the EE-PROM takes about ten minutes to complete. When the check is
completed, EE-PROM CHECK COMPLETED appears. Press any key to return to the

self-test menu.

File Edit Operate Window  Station Terminal ZditorBparae® WAL HR COver Break
Station Name ;
Freguency( T-R J - U okHZ )
Comp———— EE-FM Check —————— Error

—————— Check Address : FFFF O K i

LFE-ROM Check completad. Press any key to escape.

Fig. 9-5 EE-PROM Test Screen
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MAINTENANCE AND TROUBLESHOOTING Self Test

REMOTE Test

This test checks for proper data exchange between the DP-5 and connected transceiver. If
the result of the test is NG, check the I/O interface on the Control Board. Upon completion
of the test, REMOTE CHECK COMPLETED appears. Press any key to return to the

self-test menu.

File Edit Operate Window Station Terminal Editorf SN WRU HR Over Break

————————————————————————————————————————————— 1990-10-08 16:05 (JST)---- Caps
Station Name
Frequency( T/R ) ¢ e ( kHz 3
Comp——————— Remote Check ————————— Error Mark Space
Sen Tx Data Rx Data ro Q ARQ Time : 0 ( sec )
—————— Remote A : £f ff QK |=rmmmmm e mmm s e m e e -
Remote B ¢ £f ff 0K

Remote Check completed. Press any key to escape.

Fig. 9-6 REMOTE Test Screen

LINE Test

The Line test verifies operation of the tone modulator/demodulator and associated filtering
and timing circuitry. Upon completion of the test, LINE TEST COMPLETED appears.

Press any key to return to the self-test menu.

File Edit Operate Window Station Terminal Editorigiioeg WAU HR Over Break
Station Mame
Fregquency( T-R ) : . ( kHz
Comp————— Line Check — Error

—————— D I\ e e m - e e e e e = e o

Lire Check compl=ted. Press any key to escape.

Fig. 9-7 LINE Test Screen
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Self Test MAINTENANCE AND TROUBLESHOOTING

TONE Test 1 (All Characters)

This test (continuously) checks for proper transmission of all figures, letters and codes. To
conduct the test, call a station in either ARQ or FEC modes. Further, it is necessary to set
the ECHO to ON on the terminal menu. Execute the test, confirming that all characters are
transmitted correctly. EXECUTING TONE TEST 1 appears during the testing. Since the
test is conducted continuously, you may press any key to stop the test and return to the
self-test menu.

File Edit Operate Window Station Terminal Editor]SElia WAU HR Over Break

Station Name i NAGASAKI-6
Frequency( T/R ) : 0.00 ~ 0.00 € kHz )

Comm Status : ST BT Lock Error

Executing Tone Test 1. Press any key to escape.

ABCDEFGHIJKLMMOPORSTUUIWNXYZ 1234567830~ 7: (), » * =/+abcdefghi ik lmnopgratuy
Wxyz

ABCDEFGHI JKLMNOFPAESTUMWXYZ12345E7890-7: (), , ' =~+albcdefghi ikimnopgratuwv
WXYZ

ABCDEFGHI JKLMNOPORSTUUWKYZ

Fig. 9-8 All Characters Test Screen
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MAINTENANCE AND TROUBLESHOOTING Self Test

TONE Test 2 (Fox)

This test (continuously) checks for proper transmission of the test message THE QUICK
BROWN FOX JUMPS OVER THE LAZY DOG 0123456789. In order to conduct the test,
call a station in either ARQ or FEC Modes. Execute the test, confirming that the phrase is -
transmitted correctly. EXECUTING TONE TEST 2 appears on the display during the

testing. To escape from the test, press any key.

File Edit Operate Hindow Staticn Terminal EditorfTYINR WAU HR Over Break

Station Name : NAGASAKI-6
Frequency( T-R ) : 0.00 ~ 0.00 C kHz )
Comm Status : BRE Lock Error

Executing Tone Test 2. Press any ksy to escape.

THE QUICK BROWN FOX JUMFS OUER THE LAZY DOG 0123456789
THE QUICK BROWM FOX JUMPS OUVER THE LAZY DOG 0123456759

THE QUICK BROWN FOX JUMPS QUER THE LAZY DOG 0123456759
Fig. 9-9 FOX Transmission Test

TONE Test 3 (Beta)

You may check for proper transmission of the idle signal 8. Call up a station using the ARQ
mode. Execute the test, confirming that the signal is output correctly. To escape from the
test, press any key.

TONE Test 4 (Mark)

This test outputs the mark signal through the LINE OUT terminal, where a frequency
counter may be connected, to confirm its frequency (1615 Hz).

TONE Test 5 (Space)
TONE Test 5 verifies the space signal frequency (1785 Hz).

TONE Test 6 (BY)

This test verifies the frequency of the space B (1785 Hz) and mark Y (1615 Hz), using a
spectrum analyzer.

* You can distinguish the above tone tests by monitoring the line out monitor.
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Self Test

MAINTENANCE AND TROUBLESHOOTING

MANUAL CONTROL Test

This test checks each control signal for external equipment (Transmitter/Receiver/
Transceiver/Buzzer). When the test is selected the following prompt appears:

File Edit Operate Window Station Terminal EditorJEEIUS WRU HR Over Break

--------------------------------------------- 1990-10-08 16:13 (JST)---- Caps
Station Name ¢ NAGASAKI-8M
Frequency( T/R ) : 8785.00 ~ 8965,00 ( kHz 3
Comm Status : Connect Send Lock Error Mark Space
Sending Volume 1100 ¢ %) ARQ Error : 0 ARQ Time : 0 ( sec )

Hit 1 - 8 keys to change control. Press ESC key to escape.

Manual Control

Fig. 9-10 Manual Control Test Screen

Hit keys 1-8 one by one, observing that external equipment connected functions normally.
Key and corresponding control port are as follows:

1Key oo TX KEY signal on and off

2Key........... ..... RX MUTE signal on and off

3Key.nnenns HT signal on and off

aKey................ ALARM signal on and off

5-8 Keys............ Not used

PRINT Test

The printer can be checked for proper functioning by the print test. To escape the printer
test, press the ESC key.

6789:;<=>?7@ABCDEFGHI JKLMNOPQRSTUVWXYZ[¥1"_"abecdefghijkimnopqrstuvwxyz{!}~

I"RS%E () e+, -,
TURSXE (I %+, -,
PURSKE ()4, -,
TURSXE (D xe -
PMESHE () h+ -,
IVHSXE () x+, -,
I"BS%B' () kv, —,
PYRSXE () k+, -,
I"HEXE (I ke, -,
PURSRE (D ke, -,
1"ESXE () x4+, ~,

/0123456789 ;<=>?@ABCDEFGHI JKLMNOPQRSTUVYWXYZ[¥1"_"abcdefghi jklmnopgrstuvwxyz{!}~
/0123456789:;(=>7@ABCDEFGHI JKLMNOPQRSTUVWXYZ[¥]"_"abcdefghi jklmnopgrstuvwxyz{!}"~
/0123456789:;<=>?@ABCDEFGHI JKLMNOPQRSTUVYWXYZ[¥]1"_"abcdefghi jkimnoparstuvwxyz{i}”~
/0123456789: ;<=>?@ABCDERGHI JKLMNOPQRSTUVWXYZ[¥1"_“abcdefghi jklmnopgqrstuvwxyz (i}~
/0123456789:;(=>?@ABCDEFGHIJKLMNOPQRSTUVWXYZ[¥]"_‘abcdefghiJklmnopqrstuvwxyz(!)~
/0123456789:;<=>78ABCDEFGHI JKLMNOPQRSTUVWXYZ(¥1"_"abcdefghi jklmnopgrstuvwxyz (1}~
/0123456789 ;<=>?@QABCDEFGH] JKLMNOPQRSTUYWXYZ(¥]"_'abcdefghi Jklmnoparstuvwxyz{i}~
/0123456789 ;<=>?@ABCDEFGHI JKLMNOPQRSTUVWXYZ[¥]"_"abcdefghil jKklmnopgrstuvwxyz (!}~
/0123456789 ;<=>?@ABCDEFGHI JKLMNOPQRSTUVYWXYZ[¥1"_'abcdefghi jklmnopgrstuvwxyz(i}~
/0123456789:;<=>?@ABCDEFGHI JKLMNOPQRSTUVWXYZ[¥1"_"abcdefghl jklmnopqrstuvwxyz (I}~
/0123456789 ;<=>?@ABCDEFGHI JKLMNOPQRSTUYWXYZ[¥]"_"abcdefghl jk

Fig. 9-11 Print Test Screen
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MAINTENANCE AND TROUBLESHOOTING Self Test

SCREEN Test

This test displays a test pattern to check the CRT for error. To escape from the test, press
any key.

MONITOR BEEP Test

This test lets you set the volume of the alarm monitor. Enter 0 to turn the alarm monitor off,
or 1-7 to adjust the volume in ascending loudness.

File Edit Operate Window Station Terminal Editor]Itea WRU HR Over Break

i it 1990-10-08 16:11 (JST)---- Caps
Station Name : NAGASAK!-8M
Frequency( T/R ) : 8765.00 » 8965.00 ( kHz )
Comm Status : Connect Send Lock Error Mark Space
Sending Uolume : 100 ( %) ARG Error : 0 AROQ Time : 0 ( sec )

Monitor Beep Check
Hit 0 - 7 keys to set monitor level. Press ESC key to escape.

Fig. 9-12 Monitor Beep Check Screen

MONITOR LINE IN/LINE OUT Test

This test generates a test signal through LINE IN and LINE OUT terminals to adjust the
volume of the line in/line out monitor. Enter 0 to turn the monitor off, or a number from 1-7
for volume adjustment.

FD READ/WRITE Test

The FD READ/WRITE test checks if the floppy disk drive can write to or read from a floppy
disk. To conduct the test, use a formatted floppy disk having more than 1 KB free memory.
Upon completion of the test the result of the check and the indication FD READ/WRITE
CHECK COMPLETED appear. Press any key to return to the self-test menu.

File Edit Operate Window Station Terminal EditorliTItSM WRU HR Over Break

————————————————————————————————————————————— 1990-10-08 16:17 (JST)---- Caps
Station MName 't 'NAGASAKI-8M
Frequency( T R ) : 8765.00 » 8965.00 ( kHz )
Comm Status : Connect Send Lock Error Mark Space
Sending Yolume £ 100 ( %) ARQ Error : 0 ARQ Time : 0 ( gec

FD Read 7 Hrite Check

FD Read-Write Check CK.

FD Read-Write Check completed. Press any key to escape.

Fig. 9-13 FD Read/Write Check Screen
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INSTALLATION

General

This chapter covers the installation of the DP-5 and Printer PP-500 (optional supply). The
installation consists mainly of siting and mounting the display unit and the printer, connec-
tion of cables from external equipment and connection of the keyboard.

Mounting Guidelines

The DP-5 is designed for tabletop mounting. It may be installed almost anywhere provided
the location satisfies the following conditions:

e The ambient temperature range is 0 - 40°C.
e Select a place where the keyboard can be easily operated while viewing the display screen.

e The length of the interface connection cable is. Keep this figure in mind when selecting a
mounting location.

e Locate the unit a sufficient distance from air conditioners, heat sources and ventilation
fans.

o Water splash will most assuredly harm the sensitive components inside the unit. Keep the
unit away from areas subject to water splash or water spray.

e Select a place where vibration is minimal.

e Leave enough space around the sides of the unit to permit checking and maintenance and
to allow for circulation of cooling air.

e Keep the unit out of direct sunlight.
e Keep the unit away from magnetic fields (telephone, refrigerator, compass, etc.)
e The floppy disk drive will not function properly if the unit is tilted more than 15 degrees.

e The CRT horizontal and vertical synchronizing frequency of the DP-5 may cause picture
distortion to nearby CRT’s which these frequencies are different from each other. Leave
at least 10 cm space between the unit and other CRT’s.

Horizontal synchronizing frequency of DP-5: 24.5 kHz
Vertical synchronizing frequency of DP-5: 55.4 Hz

o Keep the following compass distance

Main Unit DP-500 Printer PP-500
Standard 1.6 m 1.0m
Steering 1.0m 05m
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INSTALLATION Mounting

Mounting

Procedure

1. Separate the mounting base from the unit by loosening the two screws at the front of the
mounting base.

3 FIXING

X °~ 7SCREWS
//

o d

Fig. 10-1 Display Unit Front View

2. Fix the mounting base to the chosen location by using 12 tapping screws or four hex head
bolts. Refer to the figure below.

Yigre,
z 63 222 , 2
Y | 7
~Heé A g
k¢ |
ol el g -3 I
~ - l 4-912 Fixing Holes
| by select either
L) :7-'# | 4-06 Fixing Holes [ fixing method
4 —
5 L4L3. 49'4 12
- 74.9

T,

Fig. 10-2 Mounting Dimensions of the Display Unit
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Mounting INSTALLATION

3. Lay the unit on top of the mounting base. Referring to the figure below, run a copper strap
between the unit and the mounting base to ground the unit.

v T
A Secure with - g
Copper Stra\p_; ® SCrew. © ©
Lo ' ' Copper Strap
= - A:A
li 2 9O | REAROF ! s
DISPLAY UNIT S =>

Fig. 10-3 Grounding the Display Unit

4. You should now install the printer (optional supply). The printer also is designed for
tabletop mounting. Select a location which is within five meters of the DP-5. Fix the
mounting bed by using four screws. Then, fix the printer by using printer mounting fixtures

1 and 2.

FIXTURE

MOUNTING BED 300 (D) X 396 (W)

Fig. 10-4 How to Install the Printer
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INSTALLATION Mounting

5. Referring to the interconnection diagram on page S-1, fit connectors to the connection
cables for peripheral equipment.

6. Connect the cables to the connectors on the back of the DP-5.

FM-14-2P

{connector fitted)
4 @:}—*Ship's Mains
O< 10-40vDC
REMOTE A REMOTE B SRCNBA16-10P
TRANSCE Vii:] O — @;’ QDI F/MEr01E3
PRINTER CONTROL T
[ ] [ —3 Input
o/ @
PRINTER //// T T T T
{ j | |

(connector fitted)

NOTE: The TX KEY line inside the REMOTE A or B connector will be connected to BK line
of transceiver. Note that the maximum rate of this line in 50 mA.

Fig. 10-5 Connectors on the Rear of the DP-5

7. Plug the keyboard interface cable into its connector on the DP-5. If desired, the keyboard
can be fixed to the tabletop. Refer to the figure below.

s /o 5
/T[T
o 7

g

Fig. 10-6 Fixing the Keyboard
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Terminal Settings

Terminal Settings

The screen for selecting communication conditions appears by pressing function key Fé. Fig.
10-7 shows the TERMINAL screen.

Terminal
ST (%Y Change Default
Rx MSG Save OFF Main Disk
Active File Auto Send QFF ON
Signal Tracking OFF ON
Edit before Sending NO YES
ARQ Error Count OFF ON
Communication Time OFF ON
Dual Font (Bold: Sending) OFF ON
Echo OFF ON
Sending Volume display QFF ON
Comm. Status display OFF ON
x| ARQ/FEC Center Freq 1500 1700 1900 0 (Hz)
* Sshift Freg + 85 + 0 (Hz)
DIRC Center Fregq 1500 1700 1900 0 (Hz)
Shift Fregq + B5 + 0 (Hz)
Rate (wpm) 60 66 75 100 132
CW Mod Fregq 615 1785 (Hz)
Rate (wpm) 10 12 14 16 18 20 22 24 26 28
Line Out Level (dBm) 0 (=30 — 10)
*| Remote A Mode OFF RCVR XMT RT DSC
* Rate (baud) 300 600 1200 2400 4800 9600
* Start Bit 1 Bit
* Data Bit 7 Bit B Bit
* Stop Bit 1 Bit 2 Bit
* Parity Bit Even 0dd None
* Delimiter CR CR + LF LF
MIF Tune OFF ON
Freeze OFF ON
AGC OFF ON
+| Remote B Mode OFF RCVR XMT RT DSC
* Rate (baud) 300 600 1200 2400 4800 9600
* Start Bit 1 Bit
* Data Bit 7 _Bit 8 Bit
* Stop Bit 1 Bit 2 Bit
* Parity Bit Even 0dd None
* Delimiter CR CR + LF LF
MIF Tune OFF ON
Freeze OFF ON
AGC OFF ON
x| CIF/NMEA Mode NMEA CIF
x| CIF Rate (baud) 600 1200 2400 4800

Fig. 10-7 Terminal Screen

Procedure

When the LOCK of the SET UP line is in inverse video, press [ | ] key to scroll the display,
to refer the items to have been set. If you want to change a setting, press the [-] key to display
the CHANGE of the SET UP line in inverse video. (However, items marked with * key can
not be changed.) And press the [ | ] key to select a desired item, then press the [»] or [«] key
to set a desired one. (The DEFAULT of the SET UP line is used only for factory adjust-
ment.)
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Terminal Settings

Menu Description

Set Up

RX MSG Save

Active File Auto Send

Signal Tracking

Edit before Sending

ARQ Error Count

Communicate Time

Dual Font

Echo

Sending Volume
Display

Comn. Status Display

ARQ/FEC Center
Freq *

Shift Freq *
DIRC Center Freq *

Shift Freq *

Changes the terminal setting.

An incoming message can be saved automatically to the
main memory or a floppy disk.

When ON is selected, a message just made or one opened
from the memory is automaticaly sent immediately after
calling and establishing a connection with a station.

The receive filters of this unit can automatically track the
incoming signals within about +80 Hz.

No: Transmits keying operation one by one.
Yes: Transmits message only when the ENTER key is

pressed after confirming the text you just typed.

A message transmitted with ARQ can be retransmitted up
to 32 times until i1t 1s received error free.

Turns the elapsed communication time display on and off.

When the DUAL FONT feature is on, incoming messages
appear in italic-like typeface, outgoing messages in gothic.

Select ON to display an outgoing message while it is being
transmitted.

Shows percentage of message (file) transmitted, from 0-
100%.

Turns the communication status display (showing commu-
nication status, percentage of message transmitted, ARQ
error rate, and ARQ time) on and off.

The center AF frequency for ARQ/FEC communication
mode is normally 1700 Hz. For GMDSS the center fre-
quency s 1700 Hz.

The most commonly used shift frequency is =85 Hz.
The center frequency for FSK is 1700 Hz.

A commonly used shift frequency is +85 Hz.

* May be changed depending on requirements.
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Terminal Settings

Rate (wpm)

CW Mod Freq

Rate (wpm)

Line Out Level

Remote A
Remote B

Mode
Rate (baud)
Start Bit
Data Bit
Stop Bit
Parity Bit
Delimiter

MIF Command
Tune

Freeze

AGC

CIF/NMEA Mode

CIF Rate (baud)

Selects the quantity of words transmitted per minute in the
FSK mode. The typical rate is 60 wpm. Set the rate accord-
ing to receiving station.

Selects the CW modulation frequency.

Selects the quantity of words transmitted per minute in the
CW mode. (It is not necessary to set the same rate as used
on receiving station.)

The AF out level is adjustable between -30 to + 10 dBm.
(-10to 10 dBm is needed for GMDSS). The factory setting
is 0 dBm; however, set the level to match the transceiver
used.

Used to set communication conditions of Remote A
and/or Remote B. If no equipment is connected to Re-
mote B, just leave the default settings (OFF).

Refer to next page.

Select RCVR, XMT, RT or DSC if FURUNO radio
equipment is connected. All the other conditions (Rate
thru Delimiter) are automatically set.

RCVR: Receiver

XMT: Transmitter

RT: Radiotelephone

DSC: Digital Selective Calling Equipment
Select OFF if a equipment other than FURUNO radio is
connected. In this case, if it is controlled by the DP-5 you
should set communication conditions (line settings) ac-
cording to the equipment connected.

When FURUNO transmitter is connected, the DP-5 send
antenna coupler tuning command at ON position.

When FURUNO radio equipment is connected, the DP-5
sends freeze command to freeze the panel operation of
the equipment connected.

Set AGC on for radio equipments which AGC command
is supported in the MIF format so that the gain is automat-
ically controlled to best condition for telex mode. (Refer
to page 10-13.)

The DP-5 can display ship’s L/L position, water tempera-
ture, water depth, ship’s speed and heading when the DP-5
is connected to a device or interface which can output
these data in CIF or NMEA format. This menu selects the
format of the navigation device connected.

Selects the baud rate of the navigation device connected.
The most common baud rate is 4800 bits/second.
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Terminal Settings PREPARATIONS

Example of interconnection and terminal setting

1]

Setting in the "Terminal” menu

Remote A mode OFF RCVR XMT RT DSC

DP-5

Remote A  Remote B Remote Bmode OFF RCVR XMT RT DSC

_{ H [ H Rate (baud) “'
Start Bit ‘
FURUNO Transceiver DSC Terminal Data Bit No chan
with MIF format DSCS5R Stop Bit B
. FS-1500, FS-5000 Series Parity Bit
Delimiter _

2]

| DP-5

Setting in the "Terminal® menu

Remote A mode OFF RCVR XMT RT DSC

Remote A Remote B Remote Bmode OFF RCVR XMT RT DSC

*{ }_-{ I }_ Rate (/baud) —7

l 5 I Nochange
FURUNO Transmitter FURUNO Receiver Delimiter
with MIF format with MIF format
FT-158/FX-3058 RV-118/RV-128

Note: When DP-5 is connected to the rack type
radio console, set the remote mode according
to the equipments to be actually controlled by

DP-5.

Sctting in the "Terminal” menu

Remote A mode OFF RCVR XMT RT DSC

DP-5

Remote A Remote B Remote Bmode OFF RCVR XMT RT DSC

._{ }—{ Rate (baud)
S ] No change
Delimiter

Transceiver

L without MIF format
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System Settings

System Settings

Press function key F8 to display the SYSTEM screen.

System
Change Default
Monitor OFF Line In Line Out
Line In Level 0 1 2 3 4 5 6 7
Line Out Level 01 2 3 4 5 6 7
Beep Level 0 1 2 3 4 5 6 7
CRT Economy Mode OFF ON
File Partial View OFF ON
k| Slave Delay 5 msec (0-50 msec)
%! BK Timing PreTone 10 msec (0-100 msec)
X PostTone 0 msec (0-20 msec)
*%| Mute Timing PreBK 0 msec (0-20 msec)
* PostBK 0 msec (0-20 msec)
Reception Alarm OFF ON
Time System OFF UTC SMT JST
Time & Datle 1990/ 1/ 1/ 20: 0
*| Printer PP-500 OTHER
Header File Name OFF ON
Time OFF ON
Footer OFF ON
* | Language Normal Norway Sweden UK (]\[)
Self Test
Version No. Ver. 2.xx
Modem Version No. Ver. 1.10

Fig. 10-8 System Screen

Procedure

When the LOCK of the SET UP line is in inverse video, press [ | ] key to scroll the display,
to refer the items to have been set. If you want to change a setting, press the [-»] key to display
the CHANGE of the SET UP line in inverse video. (However, items marked with * key can
not be changed.) And press the [ | ] key to select a desired item, then press the [~] or [«] key
to set a desired one. (The DEFAULT of the SET UP line is used only for factory adjust-
ment.)
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System Settings

Menu Description

Set Up

Monitor

Line In Level
Line Out Level

Beep Level

CRT Economy Mode

File Partial View

Slave Delay *

BK Timing
Pretone *

Posttone *

Mute Timing
Pre BK *

Post BK *

Changes the system settings.

Selects sound source for monitoring, line in, line out or
monitor off.

Selects line in/line out sound level for monitor, 0 for OFF,
7 for maximum. (No effect on actual line in and line out
levels.)

Sets the volume of the internal monitor buzzer: O for OFF,
7 for maximum.

To extend the life of the CRT it can turn itself off automat-
ically when there is no keyboard operation after 10 min-
utes.

This menu, when turned on, displays the first line of a file
selected. This feature is useful for file search.

Sets the length of the slave delay timing in the ARQ mode.
Select a time among 0-50 ms.

Sets the timing for the leading edge of the BK signal in the
ARQ mode.

Sets the timing for the trailing edge of the BK signal.

Sets the timing for the leading edge of the mute signal in
the ARQ mode.

Sets the timing for the trailing edge of the mute signal.

* For further details, see page 10-12.

Reception Alarm

Time System

Time & Date

Printer

When ON is selected, an alarm sounds to inform you that
a message has been received.

Selects time display format; UTC, JST (Japan standard
time), SMT (ship means time; local time) or no time

display.

Sets date and time.

Selects the type of printer used. For Printer PP-500, select
PP-500. For printer PP-505, select "other".
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System Settings

Header File Name

Time

Footer

Language

Version No.

Modem Version No.

Self Test

Enables or disables header stamping of file name and/or
date-time on printing messages.

Enables or disables page number stamping on printing
messages.

Special characters used in Norwegian, Swedish or English
are selected according to the list below.

Key No. €D, @ (3  |Remarks
Normall [ ] \
Norway,
Norway )3 A o Iceland,
Greenland
Sweden A A o) Finland,
Sweden
UK @ % £ UK

Shows current program version number of the Control
Board.

Shows current program version number of the Modem
Board.

Selects self tests. For further details, see page 9-2.

JHE0 00808 Sn/a -]

L

]

I

HUOOOOOOOn00OnEs] OO0 0dos
@]@DIIIIIIII- ] JOH Dggr

@@l@l@l@]

[@JIIJ

!

[]

ED]@][@]I:]@]D] @]@D

O O EoECoO.

Fig. 10-9 Keys for Special Characters
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System Settings

INFORMATION RECEIVING STATION TIMING

RX ON L RX OFF ] RX ON
RX MUTE Signal MUTE OFF l —l MUTE OFF
to Transceiver MUTE ON
| |
l I
ll @ TX available @ 'l

Reception of I@ X @ Reception of
3 characters I(——*}‘-I‘——' 3 characters
signal —{ 11 {1
Sequence ® _f‘——’ ACK Signal {1

T

TX KEY Signal BK OFF [ BK OFF
to Transceiver ——I BK ON

I

i

End of RX Beginning of TX
® SLAVE DELAY

® BK TIMING PRE TONE

@ BK TIMING POST TONE

) MUTE TIMING PRE BK

@ MUTE TIMING POST BK

Timing values depend on the transceiver connected. Therefore some trial and error may be

necessary to find suitable values.
Default values are for FURUNQO SSB Radiotelephone model FS-5000.

Fig. 10-10 ARQ Mode Timing of IRS
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System Settings

Setting of Timing

FS-5000 series FS-1500 series RC-258
Timing (msec) FS-8000 series FS-1502 RC-508
FS-1562 FS-1552 RC-808
RC-1208
Slave Delay 5 msec 50 5
BK Timing Pretone 10 msec 50 5
Post Tone 0 msec 10 0
MUTE Timing Pre BK 0 msec 0 0
Post BK 0 msec 0 0
DP-5
Terminal Menu ON OFF OFF
MIF AGC (FS-1562 : OFF)
Remarks  [gystem setting 9934 - 1 (FS-1502)
of each 9982 - 1 9904 » 0
equipment (FS-5000/8000) 9905 - 1 ] (FS-1552) none
9906 ~» 10ms
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Mounting INSTALLATION

Complete Set

No. {Name Type Wt. (kg) Qty |Remarks

1 |Main Unit DP-500 16 1

2 |Keyboard KB-500 1

3 |Printer PP-500 5 1 Option

4  |Rectifier PR-62 3 1 Option

5 |Inverter TR-2407 8.5 1 Option

6 |Installation Materials 1 set

7 |Accessories 1set

Complete Set Illustration

DP-5 NBDP TERMINAL

2
' |
! |
| !
I
: I
| I
' I
[ MAIN UNIT TTTTTTTTTTTTTIT :
T R S .
Lo
1 0t VDG ——tYCTF 075X 3k, 41 : .
: - Do
' oo
' ' Lol
100,120V b IReCTIFIER] | A
220/240VAC,.--J.. -O'R IFIER, R
1¢,50/80Hz | i PR-62 1 N
: $DPYC-1, 25 S I
KEY ] i
| BOARD 1 PRINTER 1+ § &3 |
r IR
! KB-500 ' I
| 1 (OPTION) ! @& = |
C T L S Sig s |
' S
100,120/ | ; P&
22[1/24UVAc,---r_-_A.C..CBQL.E..FSB-EE:5.U.°‘1~.§'L.¢.5;.9 .................... ! g g |
1¢,50/60Hz | ; oo & |
pmmm==m=mo 1 ' =S
'L } | NVERTERY ! S5
24VDC T -d TR-2407 P TTTTTTTTTTIRT e §, g %j I
| bommoomon 4 Sz
MATNS | 2 8 g _:
————————————————————————— — i—
(@] C'D <
oW W
oo =
=z
S
L
o
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INSTALLATION

Mounting

Installation Materials

I B B ¥ == bp—t BHRERARIEERE
INSTALLATION MATERIALS NBDP TELEGRAPH EQUIPMENT
B5 % #p BE X R O HE| BaE ./ WE
No. N A M E OUTLINE DESCRIPTIONS QTY| REMARKS
7 — A R 05-003-0031-0 AEF
1 1
COPPER STRAP §§é§§5313° FOR DISPLAY UNIT.
L=1.2m | CODE No. | 530-300-310
Ty —7)0 D CH| YCTFO.75X2C  *3m# IR
2 DEE :
POWER CABLE FOR DISPLAY UNIT
L-3m | CODE No. | 000-112-543
S T e 17JE-23250-02 (D8C) P37 32
3 \ e (4R MALE) 2
FOR DISPLAY UN
CORNECTOR 51‘6 CODE No. | 000-120-94 o
&2
1 ES » 5 17JE~13250-02 (D8C) AEH
4 NN (XX FEMALE) 1
CTOR FOR DISPLAY UNI
CONNE 53‘6 CODE No. | 000-119-31 P T
L8
=TT S R - SRCNGA16-10P p. 37 333
5 $25 C |2 ‘ L
CONNECTOR . FOR DISPLAY UNIT
= CODE No. | 000-508-663
S A | oo M5 SUS304 AR
6 16
FLAT WASHER = FOR DISPLAY UNIT
CODE No. | 000-864-128
@FREyEVRY 25 5 x25 SUS304 AR
7 178 16
TAPPING SCREW ilhnmmnmnn;gibs FOR DISPLAY UNIT
2 CODE No. | 000-867-553
F—A— FSEMS CP05-03521 F—H— K
8 2
KEYBOARD FIXTURE 1 FOR KEYBOARD
CODE No. | 005-927-640
*—HK—-FEEHEM2 CP05-03522 *—R—RH
9 2
KEYBOARD FIXTURE 2 FOR KEYBOARD
CODE No. | 005-927-650
TN % B & 5o M4 SUS304 ¥—H—KH
10 6
FLAT WASHER FOR KEYBOARD
CODE No. | 000-864-126
@F Ry YRy 16 4 %16 SUS304 *—H— K
11 130 6

TAPPING SCREW

CODE No. | 000-867-554

FOR KEYBOARD
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Mounting

INSTALLATION

Installation Materials (cont.)

I HE R s 2= bp—s NBDP#—IH ) (T ar)
INSTALLATION MATERIALS NBDP TERMINAL (OPTION)
&5 & ¥R BE X B g /B e Rg.HZE
No. N AME OUTLINE DESCRIPTIONS QTY| REMARKS
#HEL3INTr—T 0550783-0  * Im % D
1
13P TWISTED PAIR CABLE @
L=Im | CODE No. | 000-123-571
HEL3IXTr—TN @ 0550783-0 ¥ 3m *
: ]
13P TWISTED PAIR CABLE
L=3m | CODE No. |oou-123-574
HE13IXNy—T N 0550783-0 * 5mx || | FlhEEiR
3 @ TO BE SELECTED
13P TWISTED PAIR CABLE | | (No. 1=No. 6)
L=5m | CODE No. | 000-123-581
g 2 27 & —{+ & 13%¢ 0550784-0 *lmx | —
4 | =TI :
13P CABLE W/CONNECTORS @ _—
L=1m | CODE No. | 000-123-582
fisR a2 & —ftx 130t 0550784-0 * 3m *
S5|or—7N E
13P CABLE W/CONNECTORS
L=3m | CODE No. |ooo-123-583
W a3 o —{E13% 0550784-0 * 5 %
o P, [
13P CABLE W/CONNECTORS
L=5m | CODE No. | 000-123-584
was20dr—7 0 1454231 * 5m % CIF/NMEAR]
7| ($§%Fx) I:] FOR CIF/NMEA
%P NISTFD PAIR CABLE
W/ ARMOR L=5m | CODE No. looo-m—sso
H&2xy—7 0L 1454231 * 10m * Al %R
8 | (sH%dTx) \, D T0 BE SELECTED
P TWISTED PAIR CABLE NS No. T—No. 11
h/Albon) ) = L=10m | CODE No. | 000-120-792 o. 7=t 11
wa2xsyr—7 1454231 * 15m *
o | (i) =" D
P TWISTED PAIR CABLE NS==—=
%W/ARND};F < =15 | CODE No. ]000-120—793
HaE28r—7 0 1454231 * 20m *
1o | (s E) = D
P TWISTED PAIR CABLE =———
77777 %W/ARMO?{F L=20m CODE No. |000-1zu—794
#HE20M4 TN 1454231 * 30m *
11| (s E) e D
%P TWISTFD PAIR CABLE =
W/ ARMOR L=30m { CODE No. |ouo-1zn—214
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INSTALLATION Mounting

Installation Materials (cont.)

A I < - S B W LS S =3 Ty —
PP-500
INSTALLATION MATERIALS PRINTER
#HS al {5 B3 & B A3 B Hag e #E
No. N A M E OUTLINE DESCRIPTIONS QTY| REMARKS

Ty =iz (1) CP05-03610

PRINTER FIXTURE 1
CODE No. | 005-925-550

Ty v —a (2) CPO5-03620
2 1
PRINTER FIXTURE 2
CODE No. | 005-925-560
T vs —mits 05-038-0212-0/0213-0
3 1
MOUNTING BED
CODE No. | 100-122-300
y - 7 L& §7FE-336-206W
4 1
CABLE ASSY.

CODE No. | 000-566-966

@FrRr o Ul LS 5 x30 SUS304

w

TAPPING SCREW
CODE No. | 000-802-002

TN ¥ FE & M5 SUS304

6 = 4
FLAT WASHER =

CODE No. 1000-854‘128

@OF AL UB V2 4 x12 SUS304
. 5 C2700W 6
WASHER HEAD SCREW j§‘

CODE No. ]000-881-447
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INSTALLATION

Mounting
Accessories
1<t G 55 == P IREIRERIEERE
DP-5
ACCESSORIES NBDP TELEGRAPH EQUIPMENT
B®S % o B R ® /R HE| B/ Wz
No. N A M E OUTLINE DESCRIPTIONS QTY| REMARKS
345
FZ — L h N — e\ N o | 14-034-2085-0
1 > e 1
VINYL COVER P 362
I CODE No. | 000-801-737
97
7490709 E-F 4| T MF- 2DDF
2 98 1
MICRO FLOPPY DISK D\
— | CODE No. { 000-111-708
7Y vy -
17 IF S == PP-500 ,
PRINTER
ACCESSORIES
£8 % i B B e S BB KRl Mg/ W=
Na N A M E OUTLINE DESCRIPTIONS oTvy| REMARKS
2°9u3 Al & r__l[_‘_.| A2 1PLY W
1|RECORDING PAPER 7 1
pt conE Na|000-134-903
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Abbreviation

Meaning

ADV
ACK
AGN
Bl (GS)
BK
CFM
COL
CRV
DER
DWN
EEE
FM
GA
MNS
MOM
MUTI
NA
NC
NCH
NP
NR
OCC
OK
P (or 0)
PLS (PSE)
PPR
R (RCD)
RAP
RD
RE
RPT
SRY
SVP
TAX
TEST MSG
THRU
TKS (TNX)
TLX

Advise

Acknowledge

Again

Good bye

| cut off.

Confirm

Collation

How do you receive?

Out of order

Down

Error

From

Go ahead.

Minutes

Wait (Waiting)

Mutilated

Correspondence to this subscriber is not admitted.
No circuits

Subscriber’s number has been changed.
The called party is not or no longer is a subscriber.
Indicate your call number.

Subscriber is engaged.

Agreed.

Stop your transmission.

Please

Paper

Received

I will call you again.

Read

Referrring to

Repeat

Sorry

Please

What is the charge?

Please send a test message?

You are in communication with telex position
Thanks

Telex




*al’ "OD DOi1O3N3 ONNAN4d

a-200-02559 'ON'OMA | 1H5PH ¥ L] Nmvaa dvHlS H3dd0) _ AT3AI1I3dS3Y ° W10 ONY 850, ONV ' .S13, ONY .S1d.
g B e B B uls SINET TYNOIS MNIT 0L V4 LON 00 05VDB TYNIWEIL 0L SIdIM 1IINNDI NV 8-3015 1V
95, 2 31 by 1 HOLIINNDD IACHIY ‘035 S1 SONI HLOS 1¥ 031113 SYCLIINHOD HLIM 318V NIHA
Y4351 "/ a3wozrd - \ RS 3L WHAH IS CHI0FES00E SIS 1Y
WYHAYIQ NOILJINNCIHILNI ot .3t .Jow| B ¥ o 5, CEVFHAFTLMRAARIZLECO, B8, DT P BINL-LHECET - B*
. S5-d0 ps ~ A "SNIVH 3V HLIM NOILIINNDD dV1 d3HBO4SNYHE JONVH)
WA 3L | 2 WWAVY L] a3n0uddy _ Lo CYEILASLINNGE B | Lk
4 Blotoozovy B ¥ “n" wn_.“ b w i SNIVW 3V HLI M U3HIND3Y S| YIWHOISNVHL 40 INFHIIVId3Y
i oo (WADZZ/BIAOOL BOWELICALOMUE B | 9%
e 37400 3T 201 2, "AHOLIVA NI G3LLE "#HMYIE T Gx
H-ANO 3NTY 6 >, “dWYTD HOLIINNOD MAHL OT3IHS ONPOYD
i J W oime T Cvo0s Xe) A XLH 9] ERMINLLLLCLCOELET R L vk
J0A09~04 *HEw D25L0 ADA i A @6 — Lty Lo "MIHIS AS 318YI QTIIHS ONNOYI ~
ar 1H09/05 0 | demm b | Maon~g) UM Mo 5 ) CAREILLIRTLAZYAYS £
IAGIL/OZL/OTL Q0L — == = = = m = e —— = —— = [ . ~ ! HIVIY S 5 ! D8 “UIVd DILSIML S d "#E- L AL R AT Ok
- SNIVW S.dIHS ST e ] L --——0  woseaan "AIddNS QUVAIHS "SI EWWE & |+
EBH E_
i LO%Z-d1 maw - % . e m T
| HILHIANI Yo “ <& . e
i+ o3l 33 _EQWA owN Pr— | ¢ >%slji!m¢ QM VMEET--J“
-1 T ' v '
RYE FURRCI | “ P oo o |
LK XY 5 < I o 3K XY )
(YOS "XBW) ATX XL 91 < 1 Vo ADIXL :
S ¢ ASt NN B € ! ! BoE o NN
YA, == —— = ' 9 < QND H-NI 3NITC 2L ¢ A IR !
Sei-aAdd ! IJREE 37100 3NN W 4 | b ool a-Ino 3 |
2H09/05 "9l _, , 005-8X T < vivd ! H-LNO 3NITK O ¢ " ._ mv 0F >} H-LNQ 3NIT
9 1 IwA0%2/022/028 700} ~2052dd H04 338V) IV L Gavoa A L0 g aNg-sk 6 o} NS ———1-h 6 > ONDS !
CNIVM Sdivg  (BOSdd ATV ] e q-d-% _ [G8v8 53] wmic 8 / I ”| R _
SR E/u| (Bi% anNp-Sk L g VLHA |I.F_ 2 Lo ONO-S X _
il ] — st 9 [ L5 g Sl sg-—- -0 TYNIWHEL 50
R 1 T OYE A SLk S e 8 § 5! 1513~ 5-J50
ey NP 9E A i ] sl v - — O T T
u& N ! N ! axus E T e X8 b € >l Oxy
. ASN@p Wt ! i LLE0IS0 axLye T 4 R — 5 7 o) OXL
0V p 0o b oL 1IVAIING ONG-d'c L & Py I R e
BVIVE L 6 b 6 o Jeez-SY o // ((W-3015) (@-3018) o g\ of
! ! v ' — - 3 5
M«”«mm Mﬁ x\.w w w“_ mmm%%m E_ S.cmwmmwm—_ 20-052EZ3( L} [3HA7d08N]
Svivah g9 l» 9 o 041803 -—-— - ,
.;:éw S WU b g o < sz < WS /E /1) YBLOSSO {(37dWVXT 198 #)
EVIVOp v 5 v SHOLI3NNOD HLIM 318VI BIVG EL
a8 viva b ¢ o € HO WS /E /L) €8L0550 318V Hivd EL
B WiV D 7 | S o z 2U0W XY
0057dd  3a0u15% 3 : L b | u (Y905 "xe) A3x X1k
SERMIeL e T USRI ) S R B R
erig _ e NS CMSOTSEE-HLS  wa ] R I
YaWBY 3
] ONNOYD -
y i 07
N 0 », 0N 4 an Lo ) B =
6 8 < S ME A o1}
g > Lg = I R X | 6 On9-5
— L) ! 9 4 - EVI 13 U@H»&laé
9 LI § ot Mg Lk — AL .
ano s (TR 4 IJJ 034 znyg ITJIP o LINM 104 LNOD
J0XLp 7 0! D-OxYy oxux € a — L 0N 5| C-047C
v HOXL S — € ) HOxd \LE0dSe  OXik T g - L— o33z NyoY o 4
fooba DVRAUN guo-3'¢ 4 ¢ o w8 2 Wee-1—l v
[30/v3] dEXT0 FBSAAIISD) by | w E.@L_ (@308 550 a® THA
LINGY &EEJJ.RM@&W.WKQ 401-94 VONIHS E@ [V 310rt] 20-05ZEZ3f LY g T BA X1 4v INGHATTILOIOVY 855
e me - 009L/0052 /0605754
B34 _, E—
_ . LINN NIVW TYNIWEIL JO8N ®-1ais (3dWYXT 19 1)
00540 % ¥ L3-8 d08N
9 ' S _ [ . £ ! 2 v !

F g 1 Y F o 9 ' V. 9 |




‘ON 'OMA

g-10%-02890  QVoM

PIO_M\S
B it

NMvHd

4]

ik

HY¥DYIQ JILYWIHOS TVHINTD
K3 E S

S—-dda

3L
w2

. 3Wos
_ /. . .

3]

CINUD3IHD

#

NOILI3rOdd ITONY GNIHL
¥ bt

2
a3

Q3A0HddY

e

SHHVWIY ON'oMmAd ALD [ IiH3LYW *

&

NN

[W3 L1
7 ﬁ ny

an

o m ., B A Fonlw w | 2 %
> @ ©
= 2 3
! =2 =
S = =
= % g
S = =
E] =
3
o n
. By
— m—— m m,
- ) -
il - s = 1)z ] =1
| i o v Y = z
J 3 B Y .[..r-.xfm.v.\ z
{ = ALAG AALXL w oo oo =
2 ] 208 fat
| _ 3 Py SRR == [ 88% e
: %332 e 38" (] =8 H
falatatatal AAmAAAAAAAAA T p=y -— “
— MM VM N N Y AN Y M YWY W WA WAV A W WY W M W W A W M A L ww aet o w [ - —_ — 1 -
poes $2TTT CETEAERRE g 8|t i =
Q8% S=S 22335 TTZEARER ]
- HE 555 Sen s
“evvvew [ < wvyy3d | TRFR ggg 2c8
J44i= 5 e ax -
G -, mmm | oF [ <
' Ty~ B85 | 33 EES H
' e » - - aca z=o =3 > -
) o) - - 288 g 22+ pois oS-
- Sexis EEEXv ges o B
. 5 - < == EE3Z E==iS
s = =] =]
] T v W T MW L WMWY
! 1 o oo ot !
8 EN———— - rormtm o=
1 =1 e R R - ] Wy R o el
g Yz YYINE I3z 1z = a3
g ] ] 1S a3
= = x!= =
] g == 3
t
- \
PO A AAA & =1 — P
= ,—. =
= 2 E
we Sooosninmcoms L2
AAAMAAAAAAAAAAANCNANPAAAANANA NN A - AN A v t
< P Py =
e® « e taal=—F £ 1o P - =] 1
= =TT ETETE T T ETLTITEATETRTR TR R A os RTESRS sty me o
TS T2z 33583 z33:3832% e = 22 s =
t {33 SR8 3538FA3I85°7 g < 2 £8
=2 EZ23s3cs gessezs 83% - z
= > a = = = e = = 3 o t
e =z 7= 335 8 & g
: P B 2 3 2 $52 8
- s = Sz -
? — - =
bl - - ———d
»
3
woy
) om oo Dm om
bl R o= [ra=13 =
== S =35 et 1
H s S S 3
SelliSnll|gall |8 '
» grll18y By 8¢
= 1 Ru" t 5“ t -4 i £~
= w 1 SN an x|t x
1 —_ —r
> 2 2 F Z s iy !
2 2 2 2 FEEE PR
> = = = = G _
) a = = = - [— < cgnmea
. 2 _ sgomgz i sgonzz
> oD B s - IO AT - — - L =T
t = T TR U SmmThnn oy O SnmTTNTYT 4
> &z E hdm L EEBLlrrbirsm Y E hxhmu ZEE -3
3 —_ NN . AAA A AAA s VMM AAAAAASNA B SN AN ]
> Ead P mroussen: o Seessuse < B mznuaems p Sregavsos
> -] VA O = R O eq g |b-d &= Mefrpodede-bededmpe -
)y 3 & £ ~ £ x | =
8 H 3 X & X £ 3 |z
) ! - JUIURAUIUNR AU JIORR SUSR AU US4 TITILL 2
4 & g2 & 2 3
> o 3
> ——— - ——— == NV e T W N e VvV T v e vy ~
N P S e = P - ] = 8
b3 s c|g g 5 = |g 8
3 = & 3 =
S S<
) Sxm S%n
=230 =37 !
4 ! e t baxl
> p— j—
' w ~~ZZ ! =3[! ~_~~—z =3
= —_——Ex 1 el ~ ™ —— X m
==AE o ! ~ZT ZEAE
Hrosovonsyd es e w T - -
- - g SESIIoIIoC EESSa ——— 5| mamaxSxwm 282 RRonYRe amxxaCean AT T RxEROCREE 2
zzanzx sZxzxa=TERFRIEREE N S zzazsa ) jax S| zamaalsam < FEaaTIOL 1oL B=ERACEEE < g
e e A A A A A A A A AR A A A AAAAAARAAAA AN AR D 00 A0 00 8 0 Lo mmmanmhdon ] L AnAnammannamanana o~ PODSROLHISNISISSSIINSSPL.] BV -
: ~—
f - O3 DS CHD O MNP M et 3 D = 1 8 LIS e 4D OO - ITHI I b F et D P et CAD S = IS LIS C
=
= »y Ed —t
8 = m = =8 =
e ™ = = ) )
o= =3 S Pl
- ~ - pan m
= S m m < By
~ ™ - ko




D-T0D-02680 'gQuoKa

63

gl

LHO 1 3M
i =

vioMming | nmvag
06.-vz Avn] B M

P Y Laawoano

o] 31voS
4<zusmmk dAEN  Joo 4qg 7 RIS e
N4£3s—4£dqdN
I7L1L |NOILD3rOdd 3TINY QdIHL e..rq »\\Q G3A0UddY
4 2 # L = @ ¥
SAAVWIY _ ON*9MQ AL.O ‘I_mm:z_ AWVN zmk_
¥ L] L l o R 4] % ¥ g ¥
SNOISNIWIQ SNITNNOW 57 1 1) &
ar i

[ 53101 ONixI4
. o M i} xm
EREENARENES
¥R
S3IOH ONIXIS
Mpw 2e-y
dViLS ¥3dd0D
By —L

dVUIS 49dd0o ‘3JaYy dexjs asddoo 2an%eg
M —« T LRI e

€9 7

Zee

RARHERRRRE. V\\§

N

[0}

B

)

NOHH

I
\

W — bELI%I%v\

7

Y

GeLe

378Y0 0UY08AIN

NN

‘aoeds douBUBjULlBW ade mCOmewEm—b Py RW- ST 45 )5y
'SM2.IDS LDB0D 4O S)TOQ (|l SN duempuey Buyjunow 1o
‘Tenuew votje[[e)SUL 395 ‘BUTSSI204d B[GRD JO

.mUCGCG«Cwm_:
pue SUTHOBYD 10} ‘Pa}dBuULD Safged YiTM INo paf(nd
9Q ued JTun OS S3[QED UT YOBTS JUITDI4NS 3ABS |

T ERFHLBZT A - [ ERT L0
TRTOHEEOGINFNNEE ~CRIYE SN0 LINFIE L I el
TRTOWEFEHENE DHWEWNoON L~
"ROG AU FUE

CPeAMREUYNYMAINE Y A4l - LWF

-

gtg 06+

(¥
(€

(1

1sajo)

(v
(€
(c




FURUNO D- 2
i 1 2 { 3
LU I 0010000 2004577270004
Nz N
N \
\ —7 /
Eo 2
vy i
\,[ 'l (B[ ]
7 o | OB} rm
= @ iR @Q@@l[%‘T
2D [maool T
0 (@@ .
o |00 B0
S Ix@ oq - ©
~ alE A
o |02l
TQ CJ @[:JE] —
. = ) @DQ@* 4
™ E = O—‘ o e
= FD CJE]C]E] N
2? Eg .ﬁj C]Cj[j[]
G a8 =0
— - D85
= — CJEDEJ
= o0 |
— ‘ | 085
120 ?Q @@Q J
-
3} SIEER S
g BEoLg T
[ ) .
L 188 ?
N E .................... ": KB-500,KB-500-B
DRAWN APPRy\I’Di\A’VE /r’ygg-(s;omn,g """""""""" mlg =
STCA'LEY a Ll %Ajssé ;ﬁh‘.&gﬂo;io ; BLOCK NO. | DWG NO.K EYBOARD
7%~ i 1.Tke | (to0eD) ! €5520-G02- | ¢
FURUNOELECTRIC CO,, LTD.




FURUNO -
1 , 2 . 3
2 210 406 BITR
/FIXING HOLES
i (I __ |0
=)
~ - %
2l o 7
F %
" E gwf O 4 %
| .
. :: Eo Z
. e = = = ) | _f_%
N

| -

m

- ] ™

= I
% ///////// 0777
' 396
IQTEM 5 NAME MATJTERFAL mO'TYi WG.P\?O. RFEMAP%(S
AP&PROVE;D—%/%/% THIRD A%JGLE EROJEEITION %lTLgé . j" IJ ~/ 5
checkEo %lu/tﬂ/}a,ﬂmq Scals l/5 PF‘D%SOO PRINTER
SR AWK {[Fj‘ﬁ}i:uc'wiz We1GhT 5 ks ?wc.N%. _Q__,5 520-G03-C

TIIDIINIA ! DrATDII M A T




FURUNO

> 3 D-4
180 B AT 5T

7 166 4-27 FIXING /—’aot.fs

, 183 /

! iy o ] Jr
& e T —— J
|t —

@C‘ B C N Hl

4 - "’ 1

(] D C ™

b B
N v
(] FURUNO D X [ N W
a @b L —t
O 4§ ==
'& 3a OFF NS :
A N
g 3
N L7
1) l:s
—
F_—___—__—-——ﬁ
v-71L% A 1781 |
CABLE ENTRY 2evoe [@] ¢
oUTPUT — |
(2.5 Amax) Q)| 2 T
oND T 0253257-0 X2 l
|V ] oR1
4 2sv © RBEO4 I
AC INPUT{ J + | I—
1 400/2
6
T £ ’”1‘
AC100v] ACT10V] ACZ20V] AC270V ] ' €2 ct I
X 1 @ @ I 2.24/250v 6800u /50v l—
[ X2 CHECERNCENC B
L T AR TNy AT D G VIR GBI R NS S _J
& E 2 E3 v &8 E # | m =
ITEM NAME | MATERIAL | Q'TY DWG.NO. | REMARKS
LS. W ins = : & m
OVED : S 3
< = THIRD ANGLE PROJECTION | TITLE X =R y}\ g%
% = T f e R R ‘ { PR‘bZ
CHECKED | _-. . _. | SCALE RECTIFIER UNIT
R s |
DRAWN | : WEIGHT I ke J DWG_,\%, C5003-034-¢C

FURUNO ELECTRIC CO. LTD.



FURUNO D-5
| 1 2 3
110 4 - 14x8 5 E R
MOUNTING HOLES
== (5]
( ) - 2
| |
| | 4 2
i ! - N
j | 7
| | - 0
: : < o o - N
| | 4 Y
I I i |
| o N.P a ] o - 2
| | 7 ™~
! [
| ' - A
| |
ol v isisintl | s > @
) l_‘_}.._L_v_.Lf_L.‘E. J.fl_J J /1
i ==
5| /60 s\ T a sl
: TERMINAL BOARD
i /70 [ 735 76
el [
- 784
-
}r ]“ B g A 7 & 7N T Z% DIMENSIONS
TYPE INPUT oUTPUT A B c
TR 2407 a%:JQIVADC 100t 10vac | 255 | 265 | 285
: 60HZ,
28~ 38VDC| 0.7A
h TRI20T | Ul " sa | wan. asva| 90§ | @15 | 3as
0 aF e )
- <2r ® ILvR A\ FE K
m@ @/ COMPASS SAFETY DISTANCE
MEHE STANDARD : 2.1m i
| ] B STEERING : 1.5m
/ e BRI Ru r-7iL B AR 150mm I o 7]
| Fa-z -EZAN-RELEE, _
/ . FUSE MINIMUM SERVICE CLEARANCE FROM
P-Z238 F /-7t A .
’ SIDES & WIRING SIDE : /560 mm
EARTH CABLE CLAMP so7H i
TERMINAL o BEE COATING COLOR : MUNSELL 2.567/2
fa & &h 4 & = 2 E & E3
ITEM NAME MATERIAL | Q'TY DWG. NO. REMARKS

€ & TR2407/TR3207 (70VA)

& ;| SEP.r = & %
APF’ROVED‘ t THIRD ANGLE PROJECTION

P72 R724210-3 91 58 R

# Mg O 717 R

CHECKED | ﬁdél’" | ScaLE 7( TRANSISTORIZED INVERTER OUTLINE
; = Oct- 1 .227 2 T - -

BRAWN Q% | WEIGHT a$k9§e.m§ €2007-017-8

FIIRIINO FI FCTRIC CO

1T



	SAFETY INSTRUCTIONS
	SAFETY INFORMATION FOR THE OPERATOR
	SAFETY INFORMATION FOR THE INSTALLER

	Table of Contents
	Foreword
	Specifications
	RADIOTELEX COMMUNICATION
	General
	Code Description
	ARQ Mode (A-Mode)
	FEC Mode (B-Mode)

	SYSTEM INTRODUCTION
	General
	Display Unit
	Keyboard
	Function Menus

	PREPARATIONS
	General
	Answerback Code & ID Code
	Station List
	Timer Operation
	Frequency Scanning
	Scramble Operation
	User Channel
	Text Editor Parameters

	CREATING AND EDITING FILES
	General
	Creating a File
	Saving a File
	Opening and Closing a File
	Opening a file when working area full
	Saving a File Under a New Name
	Printing a File
	Real Time Printing
	Deleting a File
	Text Editing
	Finding Text
	Replacing Text
	Communication Record (Logging)
	Printing Communication Buffer

	TRANSMITTING AND RECEIVING
	General
	Manual Calling
	Calling a Station
	Transmitting a File Message from the Memory or a Floppy Disk
	Selecting Reception Mode
	ARQ Operation
	Communication example
	FEC Operation
	Other Modes of Operation
	Timer Operation
	Scramble Operation
	Transmitter High Tension Control
	Frequency Scanning

	WINDOW MENU
	General
	Window Menu Description

	MARITEX
	General
	What is MARITEX?
	Preparation for Transmission
	Preparation of Program for Automatic Transmission
	Transmission of Telex in MARITEX System

	PRINTER (optional supply)
	MAINTENANCE AND TROUBLESHOOTING
	Maintenance
	Troubleshooting
	Self Test

	INSTALLATION
	General
	Mounting
	Terminal Settings
	System Settings

	ITU TELEX CHANNELS/FREQUENCY LIST
	INTERNATIONAL TELEX ABBREVIATIONS
	INTERCONNECTION DIAGRAM
	SCHEMATIC DIAGRAMS
	DRAWINGS



